Contents

Epson SureColor T3170/T5170 User’s Guide ............................................................................................ 9

Introduction to Your Printer .................................................................................................................. 10

Printer Features ................................................................................................................................. 10

Optional Equipment and Replacement Parts ................................................................................. 11

Notations Used in the Documentation .......................................................................................... 11

Printer Part Locations ......................................................................................................................... 11

Product Parts - Front ..................................................................................................................... 12

Product Parts - Top/Inside ............................................................................................................. 13

Product Parts - Rear ...................................................................................................................... 14

Control Panel Parts ....................................................................................................................... 15

Using the Control Panel ..................................................................................................................... 17

Changing the LCD Screen Language ............................................................................................ 17

Selecting the Date and Time ......................................................................................................... 18

Setting a Password and Locking the Control Panel ................................................................... 19

Using AirPrint .................................................................................................................................... 21

Assembling the Printer Stand and Paper Basket ........................................................................... 21

Wi-Fi or Wired Networking .................................................................................................................. 34

Network Security Recommendations .............................................................................................. 34

Wi-Fi Infrastructure Mode Setup .................................................................................................... 35

Selecting Wireless Network Settings from the Control Panel ....................................................... 36

Wi-Fi Direct Mode Setup ............................................................................................................... 38

Enabling Wi-Fi Direct Mode ......................................................................................................... 38

Wi-Fi Protected Setup (WPS) ......................................................................................................... 40

Using WPS to Connect to a Network ............................................................................................ 40

Printing a Network Status Sheet ..................................................................................................... 41

Changing or Updating Network Connections ............................................................................... 42

Accessing the Web Config Utility ................................................................................................ 42

Changing a USB Connection to a Wi-Fi Connection ..................................................................... 43

Changing a Wi-Fi Connection to a Wired Network Connection .................................................. 43

Connecting to a New Wi-Fi Router ................................................................................................ 44
Disabling Wi-Fi Features ................................................................................................................ 45

**Media Handling** ......................................................................................................................... 46

- Roll Paper Handling .................................................................................................................. 46
- Loading Roll Paper ................................................................................................................... 46
- Cutting Roll Paper ..................................................................................................................... 50
  - Cutting Roll Paper Manually ............................................................................................... 50
- Removing Roll Paper .............................................................................................................. 51

- Cut Sheet Handling ................................................................................................................... 53
  - Loading Single Cut Sheets ................................................................................................. 54
  - Loading Paper in the Auto Sheet Feeder .......................................................................... 56
  - Removing Paper from the Auto Sheet Feeder ................................................................. 60

- Creating Custom Paper Configurations .................................................................................. 63
  - Selecting Custom Paper Configurations ........................................................................... 63

- Compatible Epson Papers .......................................................................................................... 64

- Paper or Media Type Settings - Printing Software ................................................................ 66

- Selecting the Paper Settings for Each Source - Control Panel ........................................... 67

- Paper Type Settings - Control Panel ..................................................................................... 68

**Printing from a Computer** ......................................................................................................... 69

- Printing with Windows ........................................................................................................... 69

  - Selecting Basic Print Settings - Windows ....................................................................... 70
    - Document Size Options - Windows .................................................................................. 72
    - Paper Source Options - Windows .................................................................................... 72
    - Print Mode Options - Windows ......................................................................................... 73
    - Color Mode Options - Windows ........................................................................................ 73
    - Level Options - Windows .................................................................................................. 74
    - Using Layout Manager - Windows .................................................................................... 76

  - Selecting Print Layout Options - Windows ....................................................................... 81
    - Page Layout Options - Windows ....................................................................................... 82

  - Selecting Advanced Settings - Windows .......................................................................... 83
    - Roll Paper Options - Windows ........................................................................................ 84

  - Selecting Additional Settings - Windows .......................................................................... 85

- Printing Your Document - Windows ..................................................................................... 86

- Checking Print Status - Windows ............................................................................................. 87
Using the Control Panel Menus.............................................................................................................. 119
  Accessing the Printer's Menus ................................................................................................. 119
  Paper Setting Menu ............................................................................................................... 120
  Basic Settings Menu ............................................................................................................... 122
  Printer Settings Menu .............................................................................................................. 124
  Network Settings Menu ......................................................................................................... 130
  System Administrator Settings Menu ...................................................................................... 130
  Maintenance Menu .................................................................................................................. 132
  Printer Status/Print Menu ...................................................................................................... 133

Replacing Ink Cartridges and Maintenance Boxes........................................................................... 134
  Check Cartridge and Maintenance Box Status ......................................................................... 134
  Checking Ink Cartridge and Maintenance Box Status on the LCD Screen ......................... 134
  Checking Ink Cartridge and Maintenance Box Status with Windows .................................. 135
  Checking Cartridge and Maintenance Box Status - Mac ..................................................... 136
  Purchase Epson Ink Cartridges and Maintenance Box ..................................................... 137
  Ink Cartridge and Maintenance Box Part Numbers .............................................................. 138
  Removing and Installing Ink Cartridges .............................................................................. 138
  Replacing the Maintenance Box ......................................................................................... 141

Adjusting Print Quality ................................................................................................................... 144
  Print Head Maintenance ......................................................................................................... 144
  Print Head Nozzle Check ....................................................................................................... 144
  Checking the Nozzles Using the Product Control Panel ..................................................... 145
  Checking the Nozzles Using a Computer Utility .................................................................. 146
  Print Head Cleaning ............................................................................................................... 148
  Cleaning the Print Head Using the Product Control Panel ................................................ 149
  Cleaning the Print Head Using a Computer Utility ................................................................ 150
  Using the Powerful Cleaning Utility .................................................................................... 152
  Adjusting Print Quality Using the Product Control Panel .................................................. 154
  Cleaning the Auto Sheet Feeder ............................................................................................ 156
  Cleaning the Roll Paper Feeder ............................................................................................. 157

Maintenance and Transportation .................................................................................................... 158
  Replacing the Cutter .............................................................................................................. 158
  Moving or Transporting Your Product ................................................................................... 161
Discharging Ink............................................................................................................................ 163

Solving Problems .......................................................................................................................... 165
Checking for Software Updates .................................................................................................... 165
Product Status Messages ................................................................................................................ 166
Resetting Control Panel Defaults ............................................................................................... 167
Solving Printer Problems .............................................................................................................. 168
  Printer Does Not Turn On ........................................................................................................ 168
  LCD Screen Shuts Off ................................................................................................................. 169
Solving Network Problems .......................................................................................................... 169
  Product Cannot Connect to a Wireless Router or Access Point .............................................. 169
  Network Software Cannot Find Product on a Network ............................................................. 171
  Product Does Not Appear in Mac Printer Window ................................................................. 172
  Cannot Print Over a Network .................................................................................................. 172
Solving Printing Problems ........................................................................................................... 173
  Nothing Prints .......................................................................................................................... 174
  Print Head Moves But Nothing Prints ..................................................................................... 174
Solving Paper Problems ............................................................................................................... 175
  Paper Feeding Problems ......................................................................................................... 175
  Printout Quality Problems ...................................................................................................... 176
  Roll Paper Jam Problems ........................................................................................................ 176
  Cut Sheet Paper Jam Problems ............................................................................................... 178
Solving Print Quality Problems .................................................................................................... 179
  Overall Print Quality is Poor .................................................................................................. 180
  Lines Are Misaligned ................................................................................................................ 181
  Prints are Scuffed or Smeared ................................................................................................. 181
  Prints are Not Positioned Properly .......................................................................................... 182
  Too Much Ink is Consumed ..................................................................................................... 183
  Cannot Make Enlarged Copies from Scanner ......................................................................... 183
Uninstall Your Product Software................................................................................................. 183
  Uninstalling Product Software - Windows ............................................................................ 184
  Uninstalling Product Software - Mac ..................................................................................... 185
Where to Get Help ....................................................................................................................... 185
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical Specifications</td>
<td>187</td>
</tr>
<tr>
<td>Windows System Requirements</td>
<td>187</td>
</tr>
<tr>
<td>Mac System Requirements</td>
<td>188</td>
</tr>
<tr>
<td>Paper Specifications</td>
<td>188</td>
</tr>
<tr>
<td>Printable Area Specifications</td>
<td>190</td>
</tr>
<tr>
<td>Ink Cartridge Specifications</td>
<td>192</td>
</tr>
<tr>
<td>Dimension Specifications</td>
<td>193</td>
</tr>
<tr>
<td>Electrical Specifications</td>
<td>194</td>
</tr>
<tr>
<td>Environmental Specifications</td>
<td>194</td>
</tr>
<tr>
<td>Interface Specifications</td>
<td>195</td>
</tr>
<tr>
<td>Network Interface Specifications</td>
<td>195</td>
</tr>
<tr>
<td>Safety and Approvals Specifications</td>
<td>196</td>
</tr>
<tr>
<td>Notices</td>
<td>198</td>
</tr>
<tr>
<td>Important Safety Instructions</td>
<td>198</td>
</tr>
<tr>
<td>General Product Safety Instructions</td>
<td>198</td>
</tr>
<tr>
<td>Ink Cartridge Safety Instructions</td>
<td>200</td>
</tr>
<tr>
<td>LCD Screen Safety Instructions</td>
<td>201</td>
</tr>
<tr>
<td>Wireless Connection Safety Instructions</td>
<td>201</td>
</tr>
<tr>
<td>FCC Compliance Statement</td>
<td>201</td>
</tr>
<tr>
<td>Binding Arbitration and Class Waiver</td>
<td>202</td>
</tr>
<tr>
<td>Trademarks</td>
<td>205</td>
</tr>
<tr>
<td>Copyright Notice</td>
<td>206</td>
</tr>
<tr>
<td>A Note Concerning Responsible Use of Copyrighted Materials</td>
<td>206</td>
</tr>
<tr>
<td>Default Delay Times for Power Management for Epson Products</td>
<td>207</td>
</tr>
<tr>
<td>Copyright Attribution</td>
<td>207</td>
</tr>
</tbody>
</table>
Epson SureColor T3170/T5170 User's Guide

Welcome to the Epson SureColor T3170/T5170 User's Guide.
For a printable PDF copy of this guide, click here.
Introduction to Your Printer

Refer to these sections to learn more about your printer and this manual.

Printer Features
Notations Used in the Documentation
Printer Part Locations
Using the Control Panel
Using AirPrint
Assembling the Printer Stand and Paper Basket

Printer Features

The Epson SureColor T3170/T5170 printer includes these special features:

High productivity
• Print accurate A1/D-size prints in 31 seconds (SureColor T5170) or 34 seconds (SureColor T3170)
• Available 50-ml color or 80-ml black high-capacity ink cartridges with next generation UltraChrome XD2, 4-color, all-pigment ink
• HP-GL2 support for CAD software
• Wirelessly print from computers, tablets, or smartphones

Reliability
• Improved anti-dust design for reduced print head nozzle maintenance
• PrecisionCore Micro TFP print head offers Precision Droplet Control
• Nozzle Verification Technology detects nozzle condition and adjusts print quality

High resolution
• Prints at resolutions up to 2400 dpi

Easy-to-use setup and operation
• Intuitive, easy-to-read, 4.3-inch, color LCD touchscreen
• Sleek, minimal design that easily fits on desktops
• Easy-to-use software
• Supports roll paper up to 24 inches (609.6 mm) [SureColor T3170] or 36 inches (914.4 mm) [SureColor T5170] and sheets up to 11 × 17 inches (279 × 432 mm)
Optional Equipment and Replacement Parts

Parent topic: Introduction to Your Printer

Optional Equipment and Replacement Parts

You can purchase genuine Epson ink, paper, and accessories from an Epson authorized reseller. To find the nearest reseller, visit proimaging.epson.com (U.S.) or proimaging.epson.ca (Canada), select your product series and product, and click the Where to Buy button. Or call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

<table>
<thead>
<tr>
<th>Option or part</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer stand and paper basket (24&quot;) [SureColor T3170]</td>
<td>SCT3170SR</td>
</tr>
<tr>
<td>Roll media spindle (24&quot;) [SureColor T3170]</td>
<td>C12C933211</td>
</tr>
<tr>
<td>Roll media spindle (36&quot;) [SureColor T5170]</td>
<td>C12C933131</td>
</tr>
<tr>
<td>Maintenance box</td>
<td>C13S210057</td>
</tr>
<tr>
<td>Replacement printer cutter blade</td>
<td>C13S210055</td>
</tr>
<tr>
<td>1-year extended Epson Preferred Plus service plan</td>
<td>EPPT3151B1</td>
</tr>
</tbody>
</table>

Parent topic: Printer Features

Notations Used in the Documentation

Follow the guidelines in these notations as you read your documentation:

- **Warnings** must be followed carefully to avoid bodily injury.
- **Cautions** must be observed to avoid damage to your equipment.
- **Notes** contain important information about your printer.
- **Tips** contain additional printing information.

Parent topic: Introduction to Your Printer

Printer Part Locations

Check the printer part illustrations to learn about the parts on your printer.

Product Parts - Front
Product Parts - Front

1 Control panel
2 Cutter cover
3 Paper basket and stand (incuded with optional stand for SureColor T3170)
13

4 Casters (included with optional stand for SureColor T3170)
5 Output tray
6 B1-size paper support (available only on SureColor T5170)
7 Edge guides
8 Auto sheet feeder
9 Cut sheet cover
10 Front cover

Parent topic: Printer Part Locations

Product Parts - Top/Inside

1 Roll paper cover
2 Paper feeder
3 Ink cartridges
4 Ink cartridge cover
5 Roll paper spindle
6 2-inch core paper stop (left side is removable)
7 Roll paper spindle holders

**Parent topic:** Printer Part Locations

### Product Parts - Rear

1 Maintenance box cover
2 Maintenance box
3 AC inlet
4 Ethernet LAN port
5 Status light
6 Data light
7 OPTION port (for scanner connection)
8 USB port
9 Airflow vents

**Caution:** Do not block the airflow vents shown above.

**Parent topic:** Printer Part Locations

### Control Panel Parts

1 🏡 home button
2 ⚡ power light
3 ⚡ power button
4 LCD touchscreen
LCD Screen Display

1 Status messages
2 Roll paper information
   When roll paper is not loaded, - - - is displayed.
3 Paper Setting menu
4 Printer Status menu (or Enlarged Copy if a scanner is connected)
5 Settings menu
6 Message List (displays notifications or warnings)
7 Network Connection Settings

- : No Ethernet connection
- : Ethernet connection established
- : No Wi-Fi connection
- : Wi-Fi network error or the product is searching for a connection
- : Wi-Fi connection established; the number of bars indicates signal strength
- : No Wi-Fi Direct connection
- : Wi-Fi Direct connection established

8 Supply Status (displays remaining ink cartridge and maintenance box levels)

Parent topic: Printer Part Locations

Using the Control Panel

See these sections to learn about the control panel and select control panel settings.

Changing the LCD Screen Language
Selecting the Date and Time
Setting a Password and Locking the Control Panel

Parent topic: Introduction to Your Printer

Changing the LCD Screen Language

You can change the language used on the LCD screen.

1. Press the home button, if necessary.
2. Select Settings > Language.
You see this screen:

![Language selection screen](image)

3. Select a language.
4. Press the \(\text{home}\) button to exit.

**Parent topic:** Using the Control Panel

### Selecting the Date and Time

Before using your product, select the current date, time, and daylight saving phase in your area, and choose your preferred date and time format.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the \(\text{home}\) button, if necessary.
2. Select **Settings > General Settings > Basic Settings > Date/Time Settings > Date/Time**.
You see this screen:

![Date/Time Settings](image)

3. Select **Date/Time**.
4. Select the date format you want to use.
5. Use the on-screen keyboard to enter the current date and select **OK**.
6. Select the time format you want to use.
7. Use the on-screen keyboard to enter the current time and select **OK**.
8. Press the home button to exit.

**Parent topic:** Using the Control Panel

**Setting a Password and Locking the Control Panel**

You can set an administrator password to lock the following settings and prevent them from being changed:

- Network settings
- Certain Printer Settings
- Certain Maintenance Settings
- System Administration settings
- Web Config settings
- EpsonNet Config settings
**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

**Note:** For more information on administration settings, see the *Administrator's Guide*.

1. Press the home button, if necessary.
2. Select *Settings* > *General Settings* > *System Administration* > *Security Settings* > *Admin Settings*.
   
   You see a screen like this:

   ![Admin Settings Screen](image)

3. Select *Admin Password*.
4. Select *Register*.
5. Use the on-screen keyboard to enter a password and select *OK*.
6. Enter the password again to confirm and select *OK*.

   **Note:** Keep a copy of your password in a safe place.

7. Select *OK*.
8. Select *Lock Setting* > *On* to lock settings.

   A prompt appears confirming that you want to enable locked settings. Select *Yes* to enable the setting and return to the home screen.

   You must enter the admin password to access any of the locked settings.
Note: If you forget your password, contact Epson for assistance.

Parent topic: Using the Control Panel

Using AirPrint

AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of iOS, and Mac with the latest version of OS X or macOS.

1. Load paper in your product.
2. Set up your product for wireless printing. See the link below.
3. Connect your Apple device to the same wireless network that your product is using.
4. Print from your device to your product.

Note: For details, see the AirPrint page on the Apple website.

Parent topic: Introduction to Your Printer
Related topics
Wi-Fi or Wired Networking

Assembling the Printer Stand and Paper Basket

Follow these steps to assemble the printer stand and paper basket for the SureColor T5170 printer.

Note: You can purchase an optional printer stand and paper basket for the SureColor T3170 printer.
Before you begin, make sure you have enough space to set up the printer as shown here.

1. 2 inches (50 mm)
2. 12 inches (310 mm)
3. 6 inches (150 mm)

**Note:** At least two people are required to lift the printer onto the stand after it is assembled.
1. Make sure you have all of these items for assembly:

1. Left mounting bracket
2. Right mounting bracket
3. Support brace
4. Left leg
5. Right leg
6. Paper basket bar
7. Left leg base (square hole is the front side)
8. Right leg base (square hole is the front side)
2. Attach the support brace to the left leg base and the right leg base.

3. Use the Allen wrench to insert 4 screws into the holes on the support brace and leg bases.
4. Attach the legs to the bases.

5. Insert 8 screws (4 on each side) into the holes in the legs.
6. Push in the cloth on the paper basket bar so it does not get caught between the bar and the legs, and attach the bar to the legs.

**Note:** Make sure the L and R stickers on the paper basket bar are correctly oriented with the L and R stickers on the leg bases.
7. Insert 4 screws (2 on each side) into the holes on the paper basket bar to secure it to the legs.

8. Make sure the L and R stickers on the mounting brackets are correctly oriented with the left and right legs and attach them as shown.
9. Insert 4 screws into 4 screw holders (2 on each side) and insert them into the holes on the legs to secure the mounting brackets.

10. Slide the paper basket rod into the pocket on the end of the paper basket cloth.
11. Insert the top of the paper basket support rods through the loops on the paper basket cloth and attach them to the paper basket rods.

12. Insert the ends of the paper basket support rods into the holes on the leg bases.
13. Close the paper basket as shown.

14. On the back of the paper basket and stand, attach the loops on the paper basket cloth to the hooks on the leg bases as shown.
15. On the front of the stand, lock the casters.

16. Have at least two people lift the printer using the indented areas as shown.
**Caution:** Do not hold the printer by the paper support. You may damage it.

17. Align the notches on the printer with the notches on the back of the stand as shown and place the printer on the stand.
18. Insert 4 screws (2 on each side) into the bottom of the mounting brackets to secure the printer to the stand. On the left rear side, insert the screw through the wired loop on the printer as shown.

**Parent topic:** Introduction to Your Printer

**Related references**

Optional Equipment and Replacement Parts
Wi-Fi or Wired Networking

See these sections to use your product on a Wi-Fi or wired network.

Network Security Recommendations
Wi-Fi Infrastructure Mode Setup
Wi-Fi Direct Mode Setup
Wi-Fi Protected Setup (WPS)
Printing a Network Status Sheet
Changing or Updating Network Connections

Network Security Recommendations

To help deter unauthorized access to your product over a network, you should protect your network environment using appropriate security measures.

Security measures such as these can help deter threats such as loss of user data, use of telephone and fax lines, and other intrusions:

• **Enable security on your wireless LAN**

  Enable the appropriate security on the wireless LAN you plan to use with your product. Network security such as a network password can deter interception of traffic over the wireless LAN. Your router may already have a default password enabled by your Internet service provider (ISP). See your ISP and router documentation for instructions on how to change the default password and better secure your network.

• **Connect your product only to a network protected by a firewall**

  Connecting your product directly to the Internet may leave it vulnerable to security threats. Instead, connect it to a router or other network connection protected by a firewall. Your router may already have a firewall set up by your Internet service provider; check with your ISP for confirmation. For best results, set up and use a private IP address for your network connection.

• **Change the default administrator password on your product**

  If your product has an option to set an administrator password, change the default administrator password to deter access by unauthorized users to personal data stored on your product, such as IDs, passwords, and contact lists.

Parent topic: Wi-Fi or Wired Networking
Wi-Fi Infrastructure Mode Setup

You can set up your product to communicate with your computer using a wireless router or access point. The wireless router or access point can be connected to your computer over a wireless or wired network.

**Note:** You cannot be connected to a wired and wireless network at the same time.

1. Epson product
2. Wireless router or access point
3. Computer with a wireless interface
4. Computer
5. Internet
6. Ethernet cable (used only for wired connection to the wireless router or access point)
Selecting Wireless Network Settings from the Control Panel

You can select or change wireless network settings using your product control panel.

To install your product on a wireless network, install the necessary software by downloading it from the Epson website. The installer program guides you through network setup.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select the icon.
   You see a screen like this:

![Network Connection Settings](image)

3. Select **Router** > **Start Setup** > **Wi-Fi Setup Wizard**.
4. Select the name of your wireless network or select **Enter Manually** to enter the name manually. Use the on-screen keyboard to enter your network name.
5. Select the **Enter Password** field and enter your wireless password using the on-screen keyboard.

![Keyboard](image)

**Note:** The network name and password are case sensitive. Be sure to correctly enter uppercase and lowercase letters, and numeric or special characters.

- To move the cursor, press the left or right arrows.
- To enter numbers or symbols, select **123#**.
- To change the case of letters, select **.**.
- To delete the previous character, select **.**.
- To enter a space, select **Space**.

6. Select **OK** when you finish entering your password.

7. Confirm the displayed network settings and select **Start Setup** to save them.

8. If you want to print a network setup report, select **Print Check Report**. (Otherwise, select **OK**.)

9. Press the **home** button to exit.

You see the **printer** icon on the LCD screen and should be able to connect to your product directly from your computer or device, and then print. If you are printing from a computer, make sure you installed the network software from the Epson website.
Note: If you don’t see the 📱 icon, you may have selected the wrong network name or entered the password incorrectly. Repeat these steps to try again.

Parent topic: Wi-Fi Infrastructure Mode Setup

Wi-Fi Direct Mode Setup

You can set up your product to communicate directly with your computer or another device without requiring a wireless router or access point. In Wi-Fi Direct Mode, the product itself acts as a network access point for up to 4 devices.

1. Epson product
2. Computer with a wireless interface
3. Other wireless device

Enabling Wi-Fi Direct Mode

Parent topic: Wi-Fi or Wired Networking

Enabling Wi-Fi Direct Mode

You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or other devices without a wireless router or access point.
Note: This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.

2. Select the icon.
   You see a screen like this:

   ![Network Connection Settings]

3. Select **Wi-Fi Direct > Start Setup > Start Setup**.  
You see a screen like this:

   ![Wi-Fi Direct]

   On the smart device's Wi-Fi setup screen, select the following SSID:

<table>
<thead>
<tr>
<th>Network (SSID)</th>
<th>DIRECT-FEDCBA98</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>12345678</td>
</tr>
</tbody>
</table>
4. Use your computer or wireless device to select the Wi-Fi network name (SSID) displayed on the LCD screen, then enter the password shown.

5. Press the home button to exit.

You see the icon on the LCD screen and should be able to connect to your product directly from your computer or device, and then print. If you are printing from a computer, make sure you installed the network software from the Epson website.

Note: If you don’t see the icon on the LCD screen, you may have selected the wrong network name or entered the password incorrectly. Repeat these steps to try again.

Parent topic: Wi-Fi Direct Mode Setup

Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your product to the network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access point. If there is no hardware button, there may be a virtual WPS button in the software for the device. Check your network product documentation for details.

Using WPS to Connect to a Network

Parent topic: Wi-Fi or Wired Networking

Using WPS to Connect to a Network

If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to connect your product to the network.

Note: This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.

2. Select the icon.
You see a screen like this:

3. Select **Router** > **Start Setup** > **Push Button Setup (WPS)**.
4. Follow the instructions on the LCD screen to complete WPS setup.
5. Press the �楞 home button to exit.

You see the 📠 icon on the LCD screen and should be able to connect to your product directly from your computer or device, and then print. If you are printing from a computer, make sure you installed the network software from the Epson website.

**Note:** If you don’t see the 📠 icon, repeat these steps to try again.

**Parent topic:** [Wi-Fi Protected Setup (WPS)]

**Printing a Network Status Sheet**

You can print a network status sheet to help you determine the causes of any problems you may have using your product on a network.

Before you begin, make sure paper is loaded in the product.

1. Press the ⛑ home button, if necessary.
2. Select **Settings** > **General Settings** > **Network Settings** > **Network Status**.
You see a screen like this:

![Network Status Screen]

3. Select **Print Status Sheet > Print**.
Examine the settings shown on the network status sheet to diagnose any problems you have.

**Parent topic:** Wi-Fi or Wired Networking

### Changing or Updating Network Connections

See these sections to change or update how your product connects to a network.

- Accessing the Web Config Utility
- Changing a USB Connection to a Wi-Fi Connection
- Changing a Wi-Fi Connection to a Wired Network Connection
- Connecting to a New Wi-Fi Router
- Disabling Wi-Fi Features

**Parent topic:** Wi-Fi or Wired Networking

### Accessing the Web Config Utility

You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is connected to the same network as your product.

**Note:** For more information on the Web Config utility, see the *Administrator's Guide*. 

---
1. Print a network status sheet.
2. Locate the IP address for your product that is listed on the network status sheet.
3. On a computer or other device connected to the same network as your product, open a web browser.
4. Enter your product's IP address into the address bar.
   You see the available Web Config utility options.

Parent topic: Changing or Updating Network Connections
Related tasks
Printing a Network Status Sheet

Changing a USB Connection to a Wi-Fi Connection
If you have already connected your product to your computer using a USB connection, you can change to a Wi-Fi connection.
1. Disconnect the USB cable from your product.
2. Uninstall your product software.
3. Download and install your product software from the Epson website using the instructions on the Start Here sheet.

Parent topic: Changing or Updating Network Connections
Related concepts
Uninstall Your Product Software

Changing a Wi-Fi Connection to a Wired Network Connection
If you have already connected your product to your computer wirelessly, you can change to a wired network connection if necessary.
1. Press the home button, if necessary.
2. Select the icon.
You see a screen like this:

3. Select **Description > Wired LAN Connection Method** > **Start Setup**.
   The Wi-Fi connection is disabled. Select **OK**.
4. Connect one end of an Ethernet network cable to the product's **LAN** port.
5. Connect the other end to any available LAN port on your router or access point.

**Parent topic:** Changing or Updating Network Connections

**Connecting to a New Wi-Fi Router**

If you change the wireless router you have been using on your network, you need to update your product's Wi-Fi connection to the new router.

**Note:** If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. See your router documentation for instructions.

1. Do one of the following:
   - **Windows:** Uninstall your product software.
   - **Mac:** Go to the next step.
2. Download and install your product software from the Epson website using the instructions on the **Start Here** sheet.

**Parent topic:** Changing or Updating Network Connections
Disabling Wi-Fi Features

You may need to disable your product's Wi-Fi features if you change your network connection type or need to solve a problem with your network connection.

**Note:** Before disabling Wi-Fi features, make a note of your product's SSID (network name) and password.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select the icon.
   You see a screen like this:

3. Select **Router > Start Setup** or **Change Settings > Others > Disable Wi-Fi**.
4. Select **Yes** to disable Wi-Fi.

**Parent topic:** Changing or Updating Network Connections
Media Handling

See these sections to load and handle media on your product.
- **Roll Paper Handling**
- **Cut Sheet Handling**
- **Creating Custom Paper Configurations**
- **Compatible Epson Papers**
- **Paper or Media Type Settings - Printing Software**
- **Selecting the Paper Settings for Each Source - Control Panel**

**Roll Paper Handling**

See these sections to load, cut, and remove roll paper in your product.
- **Loading Roll Paper**
- **Cutting Roll Paper**
- **Removing Roll Paper**

**Parent topic:** Media Handling

---

**Loading Roll Paper**

Load roll paper onto the spindle before loading the roll paper in the printer.

**Note:** To prevent dust from accumulating inside the printer, always keep the roll paper cover and cut sheet cover closed unless you are loading or unloading media.

**Note:** This product does not support 3-inch core diameter media.

1. Remove any tape and protective paper from the end of the roll. Make sure the paper is cut straight across to avoid paper feeding problems.
   
   **Note:** Avoid touching the surface of your paper or leaving it on a dusty area.

2. Make sure **Load paper** is displayed on the home screen.
3. Open the cut sheet cover.

4. Release the central lock and open the roll paper cover.

5. Remove the spindle.

6. Remove the transparent paper stop from the spindle.
7. Insert the spindle into the roll paper core as shown, with the lead edge of the roll paper facing towards you.

8. Push the fixed paper stop against the roll paper until there is no gap between the paper stop and the roll paper.

9. Attach the transparent paper stop to the spindle and press it in until there is no gap between the paper stop and the roll paper.

10. Place the roll paper into the printer with the black end of the spindle on the right.
11. Insert the leading edge of the roll paper into the paper feeder until you hear a beep.

![Roll paper insertion](image)

**Note:** Make sure the leading edge of the roll paper is not bent or skewed, or a paper jam or skew error may occur.

12. Close the roll paper cover and the cut sheet cover.

**Note:** When you load B1 (27.8 × 39.4 inches [707 × 1000 mm]) paper in the SureColor T5170, raise the B1 width paper support as shown or the printout may be scuffed or soiled. Lower the support when printing on any other paper size.

![Paper support](image)

13. Select the paper type you loaded on the LCD screen and set the remaining amount, if necessary.

If your printer includes a stand and paper basket, make sure the paper basket is open to catch printouts.

**Parent topic:** Roll Paper Handling
Cutting Roll Paper

The printer has a built-in cutter that can automatically cut most paper types. When Auto Cut is turned on, paper is automatically cut after each page prints, or if the roll paper leading edge is not straight.

**Caution:** Use of the built-in cutter is not recommended for commercially available synthetic paper, as it may dull the blade and require more frequent blade replacement. When you print on this paper type, disable the **Auto Cut** setting and cut the print off the roll manually.

To switch between automatic or manual cutting methods, adjust the **Auto Cut** settings in the printer driver. The setting selected in the printer driver overrides the control panel setting.

Cutting Roll Paper Manually

**Parent topic:** Roll Paper Handling

**Related references**
- Roll Paper Options - Windows

**Related tasks**
- Selecting Advanced Settings - Mac

---

**Cutting Roll Paper Manually**

You can keep your prints on the roll until you manually cut them.

1. Turn off the **Auto Cut** setting in the printer driver or the control panel, depending on the situation:
   - If you want to cut the paper manually, turn off the setting in the printer driver. Select **Advanced** > **Roll Paper Option** > **Auto Cut**.

   **Note:** The **Auto Cut** setting in the printer driver takes priority over the setting in the control panel. The printer driver setting returns to automatic cutting when you close the application.
• If you are using a paper type that cannot be cut with the built-in cutter, turn off the setting in the control panel. From the roll paper information area, select **Advanced Media Setting > Auto Cut > Off**.

2. Print your document.

3. From the roll paper information area, select **Feed/Cut Paper**.

4. To move the paper into a cutting position, press and hold **Forward** or **Backward** until the position you want to cut appears at the dotted line as shown.

![Diagram of paper in cutting position](image)

5. To cut the paper, select **Cut**.

   • If the auto cut setting is turned off only in the printer driver, the paper is cut and the paper leading edge returns to the print wait position.

   • If the auto cut setting is turned off in the control panel, select **Cut** to manually cut the paper with scissors or select **Print Cutting Guideline** to print a line on the paper to guide with manual cutting.

**Parent topic:** Cutting Roll Paper

### Removing Roll Paper

When you finish printing on roll paper, you should remove it from the printer to avoid indenting or creasing the lead edge of the paper.

1. Open the cut sheet cover.
2. Release the central lock and open the roll paper cover.

3. Select **Remove** on the LCD screen. The roll paper rewinds and ejects automatically.

   **Note:** Make sure the roll paper is rewound completely before removing it from the printer.

4. Hold both ends of the spindle and lift it up from the spindle holder.

5. Remove the transparent paper stop from the spindle.

6. Remove the spindle from the roll paper.
7. Place the roll paper in its original package.

**Note:** Store roll paper on its end or horizontally (if the packaging end-caps are installed). Never store roll paper on its edge, as a flat spot can develop and lead to imaging artifacts on the prints. Do not store roll paper in dusty areas. Print head maintenance and cleanings increase if dust accumulates on the paper.

8. Reattach the transparent paper stop to the spindle.

9. Place the spindle back into the printer.

10. Close the roll paper cover and the cut sheet cover.

**Note:** To prevent dust from accumulating inside the printer, always keep the roll paper cover and cut sheet cover closed unless you are loading or unloading media.

**Parent topic:** Roll Paper Handling

### Cut Sheet Handling

You can load a variety of types and sizes of cut sheet paper in your product.

- Loading Single Cut Sheets
- Loading Paper in the Auto Sheet Feeder
- Removing Paper from the Auto Sheet Feeder
Loading Single Cut Sheets

You can print on a variety of cut sheet paper types and sizes up to 24 inches (61 cm) [SureColor T3170] or 36 inches (91 cm) [SureColor T5170] wide and 0.1 inch (0.27 mm) thick. You can load and print on one sheet at a time.

Before printing on cut sheets, remove any loaded roll paper, close the auto sheet feeder, and remove the output tray.

1. Make sure **Load paper** is displayed on the home screen.
2. Select **Paper Setting > Cut Sheet (1 sheet)** on the LCD screen
3. Open the cut sheet cover.

4. Load one sheet of paper, printable side up in portrait orientation. Align the right edge of the paper with the right mark line and plastic ledge on the printer and the left mark line for the paper size you are using.
5. Insert the paper into the paper feeder until you hear a beep.

Note: Make sure the leading edge of the paper is straight to prevent a skew error or paper jam.

6. Select the paper type and size you loaded on the LCD screen.

Note: When you load B1 (27.8 × 39.4 inches [707 × 1000 mm]) paper in the SureColor T5170, raise the B1 width paper support as shown or the printout may be scuffed or soiled. Lower the support when printing on any other paper size.
**Note:** If your printer includes a stand and paper basket, make sure the paper basket is open to catch the printout.

To remove a loaded cut sheet without printing, select **Paper Setting > Cut Sheet (1 sheet) > Remove**. The paper is ejected.

**Parent topic:** Cut Sheet Handling

**Related references**
- Compatible Epson Papers
- Paper Specifications

### Loading Paper in the Auto Sheet Feeder

You can load up to 50 sheets of plain paper up to 0.1 inch (0.27 mm) thick in the auto sheet feeder in the following sizes: A3 (11.7 × 16.5 inches [297 × 420 mm]), A4 (8.3 × 11.7 inches [210 × 297 mm]), Letter (8.5 × 11 inches [216 × 279 mm]), or Legal (8.5 × 14 inches [216 × 356 mm]).

**Note:** Roll paper can remain loaded when using the auto sheet feeder. Switch between paper sources in the printer driver.
1. Attach the output tray by inserting its hooks into the holes in the front of the printer.

2. Make sure **Load paper** is displayed on the home screen.
3. Open the cut sheet cover.
4. Tilt back the auto sheet feeder and pull the paper support extensions all the way out and upward.
5. Slide the edge guides out.

6. Load paper, printable side up, into the auto sheet feeder.
7. Adjust the edge guides to fit the paper width.

8. Select the paper type and size you loaded on the LCD screen.

Parent topic: Cut Sheet Handling

Related references
Compatible Epson Papers
Paper Specifications

Removing Paper from the Auto Sheet Feeder
Remove paper from the auto sheet feeder when you finish printing.

Note: To prevent dust from accumulating inside the printer, always remove any paper from the auto sheet feeder and keep the auto sheet feeder closed unless you are loading or unloading media.
1. Slide out the edge guides and remove the paper from the auto sheet feeder.
2. Fold down and push in the paper support extensions and close the auto sheet feeder.
3. Close the cut sheet cover.
4. Remove the output tray.

**Note:** Remove the output tray when printing on roll paper or cut sheets so the paper can eject smoothly.

**Parent topic:** Cut Sheet Handling

## Creating Custom Paper Configurations

You can create and store up to 10 custom paper configurations for use if printing on non-Epson paper or paper that is not supported by the Epson printer driver.

1. Load the type of paper that you want to configure in the printer.
2. Press the home button, if necessary.
4. Select a number for the custom paper configuration.
5. Select Change Name and enter a name.
6. Select OK when you are done.
7. Select Change Reference Paper.
8. Select a paper type that is similar to the paper that you want to use.
10. Select any additional settings as necessary.
11. When you finish changing the custom paper configuration settings, press the left arrow button to return to exit the menu.

**Selecting Custom Paper Configurations**

**Parent topic:** Media Handling

## Selecting Custom Paper Configurations

Once you have created a custom paper configuration, you can select the configuration whenever you print on the associated media.

1. Press the home button, if necessary.
2. Select Paper Setting.
3. Select the paper type you are printing on.
4. Select **Change Paper Type** or **Change Paper Type/Paper Size**.
5. Select **Paper Type > Others > Custom Paper**.
6. Select the custom paper configuration you want to use.
7. Press the left arrow button to exit the menu.

**Parent topic:** Creating Custom Paper Configurations

### Compatible Epson Papers

You can purchase genuine Epson ink, paper, and accessories from an Epson authorized reseller. To find the nearest reseller, visit proimaging.epson.com (U.S.) or proimaging.epson.ca (Canada), select your product series and product, and click the **Where to Buy** button. Or call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

**Note:** Paper/media availability varies by country.

**Note:** For the most updated list of supported Epson papers, visit proimaging.epson.com (U.S.) or proimaging.epson.ca (Canada).

#### Roll Paper

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Size</th>
<th>Part number</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Epson Singleweight Matte Paper</strong></td>
<td>17 inches (432 mm) × 132 feet (40.2 m)</td>
<td>S041746</td>
<td>1 roll</td>
</tr>
<tr>
<td></td>
<td>24 inches (610 mm) × 132 feet (40.2 m)</td>
<td>S041853</td>
<td>1 roll</td>
</tr>
<tr>
<td></td>
<td>36 inches (914 mm) × 132 feet (40.2 m)</td>
<td>S041854</td>
<td>1 roll</td>
</tr>
<tr>
<td><strong>Epson Doubleweight Matte Paper</strong></td>
<td>24 inches (610 mm) × 132 feet (40.2 m)</td>
<td>S041385</td>
<td>1 roll</td>
</tr>
<tr>
<td></td>
<td>36 inches (914 mm) × 132 feet (40.2 m)</td>
<td>S041386</td>
<td>1 roll</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Amount</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------</td>
<td>-------------</td>
<td>--------</td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper (260)</td>
<td>24 inches (610 mm) × 100 feet (30.5 m)</td>
<td>S042081</td>
<td>1 roll</td>
</tr>
<tr>
<td></td>
<td>36 inches (914 mm) × 100 feet (30.5 m)</td>
<td>S042082</td>
<td>1 roll</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper (170)</td>
<td>24 inches (610 mm) × 100 feet (30.5 m)</td>
<td>S041393</td>
<td>1 roll</td>
</tr>
<tr>
<td></td>
<td>36 inches (914 mm) × 100 feet (30.5 m)</td>
<td>S041394</td>
<td>1 roll</td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper (170)</td>
<td>24 inches (610 mm) × 100 feet (30.5 m)</td>
<td>S041390</td>
<td>1 roll</td>
</tr>
<tr>
<td></td>
<td>36 inches (914 mm) × 100 feet (30.5 m)</td>
<td>S041391</td>
<td>1 roll</td>
</tr>
<tr>
<td>Enhanced Adhesive Synthetic Paper</td>
<td>24 inches (610 mm) × 100 feet (30.5 m)</td>
<td>S041617</td>
<td>1 roll</td>
</tr>
</tbody>
</table>

**Cut Sheets**

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Size</th>
<th>Part number</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041405</td>
<td>50 sheets</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041667</td>
<td>50 sheets</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041331</td>
<td>20 sheets</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041257</td>
<td>50 sheets</td>
</tr>
</tbody>
</table>

Parent topic: Media Handling
### Paper or Media Type Settings - Printing Software

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this Paper Type or Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper 16 to 20 lb (60 to 75 g/m²)</td>
<td>Plain Paper</td>
</tr>
<tr>
<td>Epson Singleweight Matte Paper</td>
<td>Singleweight Matte Paper</td>
</tr>
<tr>
<td>Epson Doubleweight Matte Paper</td>
<td>Doubleweight Matte Paper</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Enhanced Matte Paper</td>
</tr>
<tr>
<td>Epson High Quality Ink Jet Paper</td>
<td>Photo Quality Inkjet Paper</td>
</tr>
<tr>
<td>Coated paper (generic)</td>
<td>Coated Paper (Generic)</td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper (170)</td>
<td>Premium Glossy Photo Paper (170)</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper (170)</td>
<td>Premium Semigloss Photo Paper (170)</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Glossy Photo Paper</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Premium Semigloss Photo Paper</td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper (260)</td>
<td>Premium Luster Photo Paper</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td></td>
</tr>
<tr>
<td>Photo paper (generic)</td>
<td>Photo Paper (Generic)</td>
</tr>
<tr>
<td>Tracing paper/vellum paper</td>
<td>Tracing Paper</td>
</tr>
<tr>
<td>Enhanced Adhesive Synthetic Paper</td>
<td>Enhanced Adhesive Synthetic Paper</td>
</tr>
<tr>
<td>Polyester banner (generic)</td>
<td>Heavy Weight Polyester Banner</td>
</tr>
</tbody>
</table>

**Note:** The settings listed here are available only when printing from your computer; they do not apply to your product's control panel settings.

**Parent topic:** [Media Handling](#)
Selecting the Paper Settings for Each Source - Control Panel

You can change the default paper size and paper type for each source using the control panel on the product.

1. Press the home button, if necessary.
2. Select Paper Setting.
   You see a screen like this:

3. Select the paper source you want to select settings for.
   You see a screen like this:
4. Select Change Paper Type/Paper Size.
5. Select Paper Type.
6. Select the paper type for the paper you loaded.
7. Select Paper Size.
8. Select the paper size you loaded.
9. Press the home button to exit.

**Paper Type Settings - Control Panel**

Select a Paper Type setting that matches the paper you loaded. If you do not see your paper type listed, select Others in the menu.

<table>
<thead>
<tr>
<th>Paper type loaded</th>
<th>Paper Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper 16 to 20 lb (60 to 75 g/m²)</td>
<td>Plain Paper</td>
</tr>
<tr>
<td>Coated paper (generic)</td>
<td>Coated Paper (Generic)</td>
</tr>
<tr>
<td>Epson Doubleweight Matte Paper</td>
<td>Doubleweight Matte</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Glossy Sheet</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Matte Paper</td>
</tr>
<tr>
<td>Tracing paper/vellum paper</td>
<td>CAD</td>
</tr>
<tr>
<td>Polyester banner (generic)</td>
<td>Heavyweight Polyester</td>
</tr>
</tbody>
</table>

**Parent topic:** Selecting the Paper Settings for Each Source - Control Panel
Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software as described on the Start Here sheet.

**Note:** If you have an Internet connection, it is a good idea to check for updates to your product software on Epson's support website. If you see a Software Update screen, select **Enable automatic checking** and click **OK**. The update scans your system to see if you have the latest product software. Follow the on-screen instructions.

Printing with Windows
Printing with the Built-in Epson Driver - Windows 10 S
Printing on a Mac
Printing CAD Drawings

Printing with Windows

You can print with your product using any Windows application, as described in these sections.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Selecting Basic Print Settings - Windows
Selecting Print Layout Options - Windows
Selecting Advanced Settings - Windows
Selecting Additional Settings - Windows
Printing Your Document - Windows
Saving, Sharing, and Customizing the Printer Settings
Selecting Default Print Settings - Windows
Changing the Language of the Printer Software Screens
Changing Automatic Update Options

Parent topic: Printing from a Computer
Selecting Basic Print Settings - Windows

Select the basic settings for the document you want to print.

1. Open a document for printing.

2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the **Print** option in the File menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

   **Note:** You may also need to select **Preferences**, **Properties**, **Print Settings**, or **Printer Properties** to view your print settings.

You see the Printer Settings window:

4. Select the **Current Settings** option or a custom setting.
5. Click **Settings** to select the **Document Size** setting that matches the size of the document you are printing.

6. If you want your printout to be a different size than the selected document size, select the **Output Size** setting.

   **Note:** If you select **Fit to Output Size**, you can select a different output size. If you select **Same as Paper Size**, the **Document Size** and **Output Size** settings are the same.

   **Note:** Select **Custom Paper Size** to set a user-defined output size.

7. Select the **Source** setting that matches the paper feeding method you are using.

8. Select the **Media Type** setting that matches the paper you loaded.

   **Note:** If you want to use paper settings that have been set in the printer's control panel, select **Use Printer Settings**.

   **Note:** Click **Acquire Info** to refresh the settings if you loaded or changed paper after closing the print dialog box.

9. Select the **Select Target** setting based on the type of document you are printing.

   **Note:** If you want the printer driver to determine print settings based on the document type, select the **Simple Settings** checkbox. Deselect the checkbox if you want to select your own color correction, print mode, or other settings.

10. If you want to prioritize quality over print speed, select **Print with High Quality**.

11. If you deselect the **Simple Settings** checkbox, the following options are available:

    - **Print Mode**: choose a printout color
    - **Color Mode**: choose a color mode to fine-tune printout colors
    - **Level**: choose speed or quality as the printing priority
    - **High Speed**: select to speed up printing, but quality may be reduced
    - **Emphasize Thin Lines**: select to smooth out jagged edges in low-resolution images
Note: The Emphasize Thin Lines setting may reduce print speed, especially if the printer is connected wirelessly. Use a wired connection if you enable this setting.

Note: Available options depend on the selected Select Target setting.

12. To see a preview of how your document will print, select Print Preview. (The preview appears after you click Print but before printing starts.)
13. To layout multiple print data or images for printing all at once, select Layout Manager.

Document Size Options - Windows
Paper Source Options - Windows
Print Mode Options - Windows
Color Mode Options - Windows
Level Options - Windows
Using Layout Manager - Windows

Parent topic: Printing with Windows
Related tasks
Printing Your Document - Windows

Document Size Options - Windows
You can select any of the Document Size options to size your printed image.

Same as Paper Size
Sizes your printed image to fit the selected paper size.

Fit to Roll Paper Width
Sizes your printed image to fit the width of the roll paper you loaded.

Fit to Output Size
Sizes your printed image to fit the selected output size.

Others
Sizes your printed image to a specified size.

Parent topic: Selecting Basic Print Settings - Windows

Paper Source Options - Windows
You can select any of the available options in the Source menu to print on the paper loaded in that source.

Roll Paper
Selects roll paper loaded in the roll paper holder.
Auto Sheet Feeder
Selects cut sheets loaded in the auto sheet feeder.

Sheet
Selects the cut sheet loaded in the paper feeder.

Parent topic: Selecting Basic Print Settings - Windows

Print Mode Options - Windows
You can select a Print Mode option to determine the color of your printouts.

Color
Select to print your document in color.

Black
Select to print your document in black and white (grayscale is supported).

Black (Bi-Level)
Select to print CAD drawings in black and white (grayscale is not supported).

Colored Paper (Yellow)
Select if you are printing your document on yellow paper. This option is used for some poster applications.

Parent topic: Selecting Basic Print Settings - Windows

Color Mode Options - Windows
You can adjust the Color Mode setting to fine-tune the colors in your printout or turn off color management in your printer software.

EPSON Standard (sRGB)
Optimizes the sRGB space and corrects the color.

Business Graphics
Performs color correction to optimize your images based on the sRGB space.

Line Drawing
Optimizes color correction for line drawings by processing the border between lines and the background as discontinuous.

GIS
Performs optimal printing for topographic maps and other geographic information system (GIS) data.

ICM
Automatically adjusts colors based on the printer’s ICC profile and the selected Media Type setting, using the Image Color Matching system. Click the Advanced button to choose the input profile and other settings.
**Note:** In most cases, you get better results by applying color management in your application, rather than in the printer driver.

**Off (No Color Adjustment)**

Turns off color management in your printer software so you can manage color using only your application software.

**Note:** An ICC profile is required if color management is turned off.

Click **Settings** to open the **Color Controls** window, where you can specify values for adjusting brightness, contrast, saturation, and individual Cyan, Magenta, and Yellow color tones. You can choose from two Gamma settings, and use either a color circle or slide bar to adjust color.

Parent topic: Selecting Basic Print Settings - Windows

**Level Options - Windows**

You can select a print speed or print quality priority for your printouts.
Speed
Select to prioritize print speed over print quality; quality may be reduced.

Quality
Select to prioritize print quality over print speed.

Max Quality
Select to use the maximum print quality; print speed may be slower.

Quality Options
Select print speed or print quality levels using a slider.

Parent topic: Selecting Basic Print Settings - Windows
Using Layout Manager - Windows

Layout Manager lets you include multiple pieces of print data created in different applications onto one sheet of paper for printing.
You can also place the same print data multiple times as shown here.
You can place print data in different sizes and orientations to maximize media usage, as shown here.
You can place print data on roll paper as shown here.

1. Open the file you want to print in your application.
2. Select the print command in your application.
3. Select the **Layout Manager** checkbox on the Printer Settings tab.

4. Choose an option for the **Document Size** setting that matches the size of the document in your application.

5. Click **OK** and then click **Print**, if necessary.
   The Layout Manager screen opens and displays one page in the layout.

6. Leave the Layout Manager screen open and repeat steps 1 to 4 to arrange additional print data. The pages are added to the Layout Manager screen.

7. Do the following to arrange objects on the Layout Manager screen:
   - Drag pages to move and resize them.
   - Use the tool buttons and the Object menu to align and rotate pages.
   - Resize and replace whole pages in the Preference or Arrangement Settings screens.

   **Note:** See the Layout Manager screen help for details.
8. Click File > Properties and select your print settings, including the size of the paper you are printing on.

9. Open the File menu on the Layout Manager screen and click Print.

   **Note:** To save the current job to a file, open the File menu on the Layout Manager screen, save the file, and close the Layout Manager screen. To open the saved file later for editing or reprinting, right-click the printer icon in the Windows taskbar, click Layout Manager, and select the file.

**Parent topic:** Selecting Basic Print Settings - Windows

### Selecting Print Layout Options - Windows

You can select a variety of layout options for your document on the Layout tab.

- To select multiple copies and their print order, select the **Copies**, **Collate**, and **Reverse Order** options.
• To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select the **Page Layout** checkbox and select the option you want.
• To print on both sides of the paper, select the **2-sided Printing** checkbox and select the options you want.
• To rotate or flip the printed image, select the **Rotate 180°** or **Mirror Image** checkbox.

**Page Layout Options - Windows**

**Parent topic:** Printing with Windows

**Page Layout Options - Windows**

You can select these Page Layout options to set up your multi-page print job.

**Note:** Available options depend on the **Paper Source** setting.

**Folded Double-Side**
Prints two consecutive pages on one sheet of paper. The second page is flipped and printed next to the first page, allowing the sheet to be folded to make a 2-sided document. Click **Settings** to select a binding edge option and set margins.

**N-up**
Prints 2 (2-up) or 4 (4-up) pages on one sheet of paper. Click **Settings** to choose the number of pages per sheet and set the page order.

**Poster**
Prints one image on multiple sheets of paper to create a large poster. Click the **Settings** button to select the layout and guideline options.

**Print Banner**
Select when using a Windows application designed for banners.

**Parent topic:** Selecting Print Layout Options - Windows
Selecting Advanced Settings - Windows

You can select advanced printing settings on the Advanced tab.

- To control how roll paper is cut after printing, select an **Auto Cut** option. Select other roll paper options as necessary.
- To adjust the ink saturation level, select **Advanced Media Control**.
- To create or edit custom printing settings, select **Custom Settings**.
- To print a color background on the page, select the **Print Bckg Color** checkbox and click **Color Settings** to select the color you want to use.
- To print the time, date, and other information about your print job at the top or bottom of the page, select the **Job Settings** checkbox and click **Details** to select the settings you want to use.

Roll Paper Options - Windows

**Parent topic:** Printing with Windows
Roll Paper Options - Windows

Select any of the available roll paper options.

Note: Some settings may not be available, depending on the Roll Paper Option you selected for your paper size.

Auto Cut

- **Off**: Select this option to cut your prints manually.
- **Normal Cut**: Creates a margin at the top and bottom of your image and automatically cuts the paper. These margins vary by media type and may be changed from their defaults using custom media settings.

![Auto Cut Diagram]

Auto Rotate

Automatically positions the image or print data to fit the roll paper.

Print Page Line

Prints lines between pages as a guide for manual cutting.

Save Roll Paper

When Auto Cut is enabled, the printer cuts the roll paper at the end of the image as positioned on the page.

Parent topic: Selecting Advanced Settings - Windows
Selecting Additional Settings - Windows

You can run maintenance utilities and select additional settings that apply to all your print jobs on the Utility tab.

- Click **Nozzle Check** to print a nozzle check pattern to check whether the print head nozzles are clogged.
- Click **Head Cleaning** to clean the print head if you notice banding or gaps in your printouts.
- Click **Epson Status Monitor 3** to check the printer’s status.
- Click **Monitoring Preferences** to select the error notifications displayed on the Epson Status Monitor 3 screen, or add a shortcut to the utility in the Windows taskbar.
- Click **Print Queue** to display a list of all waiting print jobs, view information on the data waiting to be printed, and delete or reprint the jobs.
- Click **Speed and Progress** to select various printing options.
• Click **Menu Arrangement** to arrange the **Setting**, **Media Type**, and **Paper Size** options by frequency of use.

• Click **Export or Import** to save the print settings to a file or import them from a file. This is useful when you want to select the same print settings on multiple computers.

• Select a **Language** option for the language you want to use for the printer software screens.

**Parent topic:** Printing with Windows

**Related tasks**
- Checking the Nozzles Using a Computer Utility
- Cleaning the Print Head Using a Computer Utility

**Printing Your Document - Windows**

Once you have selected your print settings, you are ready to save your settings and print.

1. Click **OK** to save your settings.

   You see your application's Print window, such as this one:
2. Click **OK** or **Print** to start printing.

**Checking Print Status - Windows**

**Parent topic:** Printing with Windows

**Checking Print Status - Windows**

During printing, you see this window showing the progress of your print job. It allows you to control printing and check ink cartridge status.

- To cancel printing, click **Cancel**.
- To see print jobs waiting to print, click **Print Queue**.

**Parent topic:** Printing Your Document - Windows

**Saving, Sharing, and Customizing the Printer Settings**

You can save groups of print settings or media settings so you can reuse them for future print jobs. You can export these settings as a file so you can share them with other users. You can also edit the settings displayed in the printer software screens.

**Saving and Sharing Print Settings - Windows**

**Editing Print Setting Displays - Windows**

**Parent topic:** Printing with Windows

**Saving and Sharing Print Settings - Windows**

You can save your print settings so you can use them for future print jobs.
1. Make sure the selected settings on the Printer Settings, Layout, and Advanced tabs are set to what you want to save.

2. Under the Select Setting dropdown menu, select **Custom Settings**.
   You see a window like this:

   ![Custom Settings Window](image)

3. Verify that your settings are correct, enter a name for the group of settings in the **Name** field, and click **Save**.

4. Do the following as necessary:
   - If you need to delete a group of settings you have created, select the name of the group of settings from the list and click **Delete**.
   - To export the settings, select the name of the group of settings, click **Export**, select a location, and enter a file name.
   - To import a group of settings, click **Import**, select the file you want to use, and click **Open**. Then use the settings to print.

Once custom settings are saved, you can select the name of the group of settings from the Select Setting dropdown menu and use them to print.
Parent topic: Saving, Sharing, and Customizing the Printer Settings
Related tasks
Selecting Basic Print Settings - Windows
Printing Your Document - Windows

Editing Print Setting Displays - Windows

You can arrange the displayed print settings so you can easily select the settings you use most often.

1. Click the Utility tab in the printer software.
2. Select Menu Arrangement.
   
   You see this window:
3. Select the item you want to edit.
4. Order or group items in the List box as follows:
   • To move and reorder items, drag and drop them in the list.
   • To add a new group (folder), click Add Group.
   • To delete a group (folder), select the group and click Delete Group.
   • To hide a group, drag and drop it to Not Display.

   Note: If you delete a group, the group folder is deleted but the items within the folder remain.

5. Click Save.

Parent topic: Saving, Sharing, and Customizing the Printer Settings

Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that program session. If you want to change the print settings you use in all your Windows programs, you can select new default print settings.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
2. Select Printer Settings.
You see the printer settings window:

![Printer Settings Window](image)

3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click **OK**.

These settings are now the defaults selected for printing. You can still change them as needed for printing in any program session.

**Parent topic:** Printing with Windows

**Related tasks**

- **Selecting Basic Print Settings - Windows**

**Changing the Language of the Printer Software Screens**

You can change the language used on the Windows printer software screens.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
2. Select **Printer Settings**.
   You see the printer settings window.

3. Click the **Utility** tab.
   You see these options:

   ![Printer Settings Window]

4. Select the language you want to use as the **Language** setting.

5. Click **OK** to close the printer software window.
   The printer software screens appear in the language you selected the next time you access them.

**Parent topic:** Printing with Windows

**Changing Automatic Update Options**

Your printer software for Windows automatically checks for updates to the product software. You can change how often the software checks for updates or disable this feature.
1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.

2. Select **Software Update Settings**.
   You see this window:

   ![Software Update Settings window](image)

3. Do one of the following:
   - To change how often the software checks for updates, select a setting in the **Check every** menu.
   - To disable the automatic update feature, select the **Never** option.

4. Click **OK** to exit.

   **Note**: If you choose to disable the automatic update feature, you can check for updates manually.

**Parent topic**: Printing with Windows

### Printing with the Built-in Epson Driver - Windows 10 S

You can print with the built-in Epson printer driver using any printing program on Windows 10 S, as described in these sections.

**Note**: The built-in Epson driver in Windows 10 S does not include all the available print settings for your product. To print with additional settings, download and install the Epson Print and Scan utility from the Windows Store. You cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.
Selecting Print Settings - Windows 10 S

Parent topic: Printing from a Computer

Selecting Print Settings - Windows 10 S

Select the settings for your print job in your Windows 10 S application.

1. Open a document for printing.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

   **Note:** You may also need to select Properties or Preferences to view your print settings.

You see a window like this:
4. Select the type of paper you loaded as the **Media** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

5. Click the **Advanced** button.

   You see a window like this:

   ![Epson ESC/P-R V4 Class Driver Advanced Options](image)

6. Select the size of the paper you loaded as the **Paper Size** setting.

7. To print multiple copies, select or enter the number as the **Copy Count** setting.

8. To print multiple copies of multi-page documents in sets, select the **Collated** checkbox.

9. Click **OK**.

   You return to the printing preferences window.
10. Select the **Layout** tab.

11. Select the orientation of your document as the **Orientation** setting.

12. Click **OK** to save your settings.

   You see your application's **Print** window.

13. Click **OK** or **Print** to start printing.

**Parent topic:** Printing with the Built-in Epson Driver - Windows 10 S

## Printing on a Mac

You can print with your product using any Mac printing program, as described in these sections.

**Note:** If you have an Internet connection, it is a good idea to check for updates to your product software on Epson’s support website.

**Selecting Basic Print Settings - Mac**
Selecting Basic Print Settings - Mac

Select the basic settings for the document you want to print.

1. Open a document for printing.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the **Print** option in the File menu, or another command. See your application's help utility for details.

3. Select your product as the **Printer** setting.

4. If necessary, click the arrow next to the Printer setting or the **Show Details** button to expand the print window.
You see the expanded printer settings window for your product:

![Printer Settings Window]

**Note:** The print window may look different, depending on the Mac OS version and the application you are using.

5. Select the **Copies** and **Pages** settings as necessary.

**Note:** If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting **Page Setup** from the File menu.
6. Select the size of the paper you loaded as the **Paper Size** setting.

   **Note:** You can reduce or enlarge the size of the printed image by selecting **Paper Handling** from the pop-up menu and selecting a scaling option.

7. Choose portrait or landscape as the **Orientation** setting.
8. Select **Printer Settings** from the pop-up menu.

   **Note:** In certain programs, you may need to select **Advanced** before you can select **Printer Settings**. For more information about printer settings, click the ? button.

   You see a screen like this:

   ![Printer Settings Screen]

9. If you want your printout to be a different size than the paper size you selected in step 6, select the **Output Size** setting in the dropdown menu.

   **Note:** If you select **Same as Paper Size**, the **Paper Size** and **Output Size** settings are the same.

   **Note:** Select **Specify Size** to set a user-defined output size.

10. Select the **Paper Source** setting that matches the paper feeding method you are using.

    **Note:** If you select **Roll Paper**, select the width of the roll as the **Roll Paper Width** setting.
11. Select the **Media Type** setting that matches the paper you loaded.

   **Note:** If you want to use paper settings that have been set in the printer’s control panel, select **Use Printer Settings**.

   **Note:** Click **Acquire Info** to refresh the settings if you loaded or changed paper after closing the print dialog box.

12. Select the **Select Target** setting based on the type of document you are printing.

   **Note:** If you want the printer driver to determine print settings based on the document type, select the **Simple Settings** checkbox. Deselect the checkbox if you want to select your own color correction, print mode, or other settings.

13. If you want to prioritize quality over print speed, select **Print with High Quality**.

14. If you deselect the **Simple Settings** checkbox, the following options are available:
   - **Print Mode:** choose a printout color
   - **Color Mode:** choose a color mode to fine-tune printout colors
   - **Level:** choose speed or quality as the printing priority
   - **High Speed:** select to speed up printing, but quality may be reduced
   - **Emphasize Thin Lines:** select to smooth out jagged edges in low-resolution images

   **Note:** The **Emphasize Thin Lines** setting may reduce print speed, especially if the printer is connected wirelessly. Use a wired connection if you enable this setting.

   **Note:** Available options depend on the selected **Select Target** setting.

15. To see a preview of how your document will print, select **Print Preview**. (The preview appears after you click **Print** but before printing starts.)

   **Paper Size Options - Mac**
   **Paper Source Options - Mac**
   **Print Mode Options - Mac**
   **Color Mode Options - Mac**
   **Level Options - Mac**

   **Parent topic:** Printing on a Mac
Related tasks
Selecting Advanced Settings - Mac
Printing Your Document - Mac

Paper Size Options - Mac

You can select any of the Paper Size options in the Printer Settings menu to size your printed image.

**Same as Paper Size**
Sizes your printed image to fit the selected paper size.

**Fit to Roll Paper Width**
Sizes your printed image to fit the width of the roll paper you loaded.

**Output Size**
Sizes your printed image to fit the selected output size.

**Specify Size**
Sizes your printed image to a specified size.

**Retain Scale**
Retains the size of the original image.

**Banner**
Select when using an application designed for banners.

Parent topic: Selecting Basic Print Settings - Mac

Paper Source Options - Mac

You can select any of the available options in the Source menu to print on the paper loaded in that source.

**Roll Paper**
Selects roll paper loaded in the roll paper holder.

**Auto Sheet Feeder**
Selects cut sheets loaded in the auto sheet feeder.

**Sheet**
Selects the cut sheet loaded in the paper feeder.

Parent topic: Selecting Basic Print Settings - Mac

Print Mode Options - Mac

You can select a Print Mode option to determine the color of your printouts.

**Color**
Select to print your document in color.
Black
Select to print your document in black and white (grayscale is supported).

Black (Bi-Level)
Select to print CAD drawings in black and white (grayscale is not supported).

Colored Paper (Yellow)
Select if you are printing your document on yellow paper. This option is used for some poster applications.

Parent topic: Selecting Basic Print Settings - Mac

Color Mode Options - Mac
You can adjust the Color Mode setting to fine-tune the colors in your printout or turn off color management in your printer software.

EPSON Standard (sRGB)
Optimizes the sRGB space and corrects the color.

Business Graphics
Performs color correction to optimize your images based on the sRGB space.

Line Drawing
Optimizes color correction for line drawings by processing the border between lines and the background as discontinuous.

GIS
Performs optimal printing for topographic maps and other geographic information system (GIS) data.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your application software.

Note: An ICC profile is required if color management is turned off.
Click **Settings** to open the **Color Controls** window, where you can specify values for adjusting brightness, contrast, saturation, and individual Cyan, Magenta, and Yellow color tones. You can choose from two Gamma settings, and use either a color circle or slide bar to adjust color.

![Color Controls window](image)

**Parent topic:** Selecting Basic Print Settings - Mac

**Level Options - Mac**

You can select a print speed or print quality priority for your printouts.

**Speed**

Select to prioritize print speed over print quality; quality may be reduced.

**Quality**

Select to prioritize print quality over print speed.

**Max Quality**

Select to use the maximum print quality; print speed may be slower.
Selecting Print Layout Options - Mac

You can select a variety of layout options by selecting **Layout** from the pop-up menu on the print window.

- To print multiple pages on one sheet of paper, select the number of pages in the **Pages per Sheet** pop-up menu. To arrange the print order of the pages, select a **Layout Direction** setting.
- To print borders around each page on the sheet, select a line setting from the **Border** pop-up menu.
- To invert or flip the printed image, select the **Reverse page orientation** or **Flip horizontally** settings.

Parent topic: Printing on a Mac

Selecting Advanced Settings - Mac

You can select roll paper settings and adjust color density from the Advanced menu.

1. Select **Advanced** from the dropdown menu.
You see this window:

![Image of settings window]

**Note:** Some settings may not be available, depending on the Roll Paper option you selected for your paper size.

2. Select one of the following **Auto Cut** settings:
   - **Off:** Select this option to cut your prints manually.
   - **Normal Cut:** Creates a margin at the top and bottom of your image and automatically cuts the paper. These margins vary by media type and may be changed from their defaults using custom media settings.

3. Select the following settings as necessary:
   - Select the **Auto Rotate** checkbox to automatically position the image or print data to fit the roll paper.
   - Select the **Print Page Line** checkbox to print lines between pages as a guide for manual cutting.
• When **Auto Cut** is enabled, select the **Save Roll Paper** checkbox to have the printer cut the roll paper at the end of the image as positioned on the page.

4. If you want to adjust color density, click **Settings**, adjust the **Black** and **Color** settings, and click **OK**.

![Advanced Media Control](image)

**Parent topic:** Printing on a Mac

### Managing Color - Mac

You can adjust the Color Matching settings to fine-tune the colors in your printout, or turn off color management in your printer software.

1. Select **Color Matching** from the pop-up menu in the print window.

![Color Matching](image)

2. Select one of the available options.

**Color Matching Options - Mac**

**Parent topic:** Printing on a Mac
Color Matching Options - Mac

You can select from these settings on the Color Matching menu.

- **ColorSync**
  Prints using standard color profiles for your product and paper to help match image colors.

- **EPSON Color Controls**
  Lets you manage color using controls in your printer software or turn off color management.

Parent topic: Managing Color - Mac

Sizing Printed Images - Mac

You can adjust the size of the image as you print it by selecting Paper Handling from the pop-up menu on the Print window.

- To collate multiple copies into sets of documents, select the Collate pages checkbox.
- To print only selected pages in a multi-page document, select an option from the Pages to Print pop-up menu.
- To adjust the order in which pages are printed, select an option from the Page Order pop-up menu.
- To scale the image to fit on a specific paper size, select the Scale to fit paper size checkbox and select a paper size from the Destination Paper Size pop-up menu.
- To restrict scaling of the image to reduced sizing, select the Scale down only checkbox. (Deselect this checkbox when enlarging the image.)

Parent topic: Printing on a Mac

Selecting Printing Preferences - Mac

You can select printing preferences that apply to all the print jobs you send to your product.
1. In the Apple menu or the Dock, select **System Preferences**.
2. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**.
3. Select **Options**.
   
   You see a screen like this:

4. Select any of the available printing options.
5. Click **OK**.

**Printing Preferences - Mac**

**Parent topic:** Printing on a Mac

**Printing Preferences - Mac**

You can select from these settings on the **Options** tab.

**Acquire printer information automatically**

Ensures that the paper size and paper type settings are automatically updated if paper is loaded or changed after closing the print dialog box.
Maintenance Call Notification
Alerts you if the maintenance box is nearing capacity or needs to be replaced.

Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software for various operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you experience issues when using a shared printing pool.

Default media type
Select the Media Type that you want to use as the default in the printer driver.

Parent topic: Selecting Printing Preferences - Mac

Printing Your Document - Mac
Once you have selected your print settings, you are ready to print.
Click **Print** at the bottom of the print window.

![Print window](image)

**Checking Print Status - Mac**

**Parent topic:** Printing on a Mac

**Checking Print Status - Mac**

During printing, you can view the progress of your print job, control printing, and check ink status.

1. Click the printer icon when it appears in the Dock.
You see the print status window:

2. Select the following options as necessary for your Mac OS version:
   • To cancel printing, click the print job and click or **Delete**.
   • To pause a print job, click the print job and click or **Hold**. To resume a print job, click the paused print job and click or **Resume**.
   • To pause printing for all queued print jobs, click **Pause** or **Pause Printer**.
   • To display other printer information, click **Settings** or **Supply Levels**.

Parent topic: Printing Your Document - Mac

**Printing CAD Drawings**

Your product can print CAD drawings from CAD software applications. You can print them from the printer driver or change settings in the product to emulate HP-GL/2 or HP RTL modes.

**Note:** Not all HP-GL/2 and HP RTL features are supported on the product.

**Printing CAD Drawings from the Printer Driver**

**Printing CAD Drawings in HP-GL/2 or HP RTL Mode**

Parent topic: Printing from a Computer

**Printing CAD Drawings from the Printer Driver**

You can print CAD drawings from your printer driver. This printing method is best for high quality views and drawings.
Note: If lines in your drawing are not printed properly, print the drawing using HP-GL/2 or HP RTL mode using the product control panel.

1. Open the file you want to print in your CAD software.
2. Click **Plot** and select your product as the printer.
3. Click **Properties**.
4. Under the **Device and Document Settings** tab, click **Custom Properties**.
   You see the printer driver window:

5. Select the **Document Size** and **Output Size** settings.
6. Select the **Source** setting.
7. Select the **Media Type** setting.
8. Choose one of the CAD/Line Drawing options as the **Select Target** setting.
9. Select any other printing settings as necessary and click **OK**.
10. Start printing your drawing from the CAD software.

Parent topic: Printing CAD Drawings

Printing CAD Drawings in HP-GL/2 or HP RTL Mode

You can change settings in your product’s control panel to print CAD drawings using HP-GL/2 or HP RTL mode. This printing method is best for maps and blueprints, or when lines need to be emphasized.

**Note:** Not all HP-GL/2 and HP RTL features are supported on the product.

1. Press the **home** button on your product, if necessary.
2. On the LCD screen, select **Settings > General Settings > Printer Settings > Universal Print Settings.**
   
   You see this screen:

   ![Universal Print Settings](image)

3. Make sure the **Paper Source** setting is set to **Roll Paper**.

   **Note:** If roll paper is not selected when HP-GL2 or HP RTL print data is sent, an error occurs.

4. Select any other settings as necessary.
5. Select the left arrow to return to the previous screen.
6. Select **HP-GL/2 Unique Settings.**
You see this screen:

![HP-GL/2 Unique Settings](image)

7. Change the settings as necessary.
8. Select the left arrow to return to the previous screen.
9. Select **Printing Language**.
   - If you are printing over USB, select **USB** and change the **Printing Language** setting to **HP-GL/2**.
   - If you are printing over a network, select **Network** and change the **Printing Language** setting to **HP-GL/2**.

   **Note:** Make sure you return the **Printing Language** setting to **Auto** when you are done printing in HP-GL/2 mode.

10. Open the file you want to print in your CAD software.
11. Click **Plot** and select your product as the printer.
12. Start printing your drawing from the CAD software.

**Parent topic:** Printing CAD Drawings
Using Your Printer as a Copier

You can connect a supported Epson scanner to your printer and print out enlarged scans on roll paper. The following Epson scanners are supported:

- DS-530
- DS-7500
- DS-70000

*Note:* Visit the Epson website for the most updated list of supported scanners.

Connecting a Scanner to Your Printer

Placing Originals in the Scanner

Printing Enlarged Copies from the Scanner

**Connecting a Scanner to Your Printer**

You can connect a supported scanner directly to the printer to print out enlarged copies.

1. Turn off the printer and the scanner.
2. Connect one end of the USB cable supplied with the scanner to the scanner port and the other end to the **OPTION** port on the back of the printer.
Placing Originals in the Scanner

See your scanner's User's Guide for instructions on placing originals in the scanner.

Note the tips below to prevent reduced print quality or other scanning problems:

- You can copy only one side of a double-sided document at a time, even if your scanner supports double-sided scanning. Place the side you want copied facedown on the scanner glass or in the automatic document feeder (ADF).
- Make sure there are no originals in the ADF if you want to scan an original from the scanner glass.
- Use the ADF to scan multi-page originals.
- Do not use the ADF if the original is printed on thick paper or cardstock.
- Do not use the ADF if JIS B1 or A0 is selected as the Reduce/Enlarge setting.
- If multiple copies are made from an original placed on the scanner glass, the original is scanned for each copy. Make sure all copies have finished printing before opening the scanner cover.

Printing Enlarged Copies from the Scanner

After the scanner and printer are connected and originals are placed in the scanner, you can print enlarged copies from the printer.

1. Turn on the printer and the scanner.

   The Enlarged Copy option appears on the LCD screen:

   ![Enlarged Copy Option](image)

   **Note:** If you do not see the Enlarged Copy option, make sure the printer and scanner cables are connected correctly and the scanner is turned on.
2. Make sure roll paper is loaded in the printer.
   
   **Note:** Only roll paper is supported for enlarged copies.

3. Select **Enlarged Copy**.
   You see a screen like this:

![Enlarged Copy screen](image)

4. Select the size of your original as the **Original Size** setting.
5. Select a **Reduce/Enlarge** option to set the output size.
   
   **Note:** If you select **Auto Fit Page**, the copy is enlarged to fit the width of the roll paper.

6. Select any other settings as necessary.
7. Select the number of copies as the **Copies** setting.
8. Select **Copy** on the printer LCD screen or the scan button on the scanner to begin copying.

**Supported Copy Sizes**

The following original and output sizes are supported for enlarged copies:
<table>
<thead>
<tr>
<th>Type</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original size</td>
<td>5 × 7 inches (127 × 178 mm)</td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm])</td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 × 11.7 inches [210 × 297 mm])</td>
</tr>
<tr>
<td></td>
<td>A5 (5.8 × 8.2 inches [148 × 210 mm])</td>
</tr>
<tr>
<td></td>
<td>B4 (13.9 × 9.84 inches [353 × 250 mm])</td>
</tr>
<tr>
<td></td>
<td>B5 (7.2 × 10.1 inches [182 × 257 mm])</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
</tr>
<tr>
<td>Output size</td>
<td>A0 (33.1 × 44 inches [841 × 1189 mm])*</td>
</tr>
<tr>
<td></td>
<td>A1 (23.4 × 33.1 inches [594 × 841 mm])</td>
</tr>
<tr>
<td></td>
<td>A2 (16.5 × 23.4 inches [420 × 594 mm])</td>
</tr>
<tr>
<td></td>
<td>B1 (27.8 × 39.4 inches [707 × 1000 mm])*</td>
</tr>
<tr>
<td></td>
<td>B2 (19.7 × 27.8 inches [500 × 707 mm])</td>
</tr>
<tr>
<td></td>
<td>17 × 22 inches (432 × 559 mm)</td>
</tr>
<tr>
<td></td>
<td>22 × 34 inches (559 × 864 mm)</td>
</tr>
<tr>
<td></td>
<td>34 × 44 inches (864 × 1120 mm)*</td>
</tr>
</tbody>
</table>

**Note:** The original size depends on the scanner you are using.

*Not supported on SureColor T3170

**Parent topic:** Printing Enlarged Copies from the Scanner
Using the Control Panel Menus

Follow the instructions in these sections to access the printer menu system and select settings.

Accessing the Printer's Menus
Paper Setting Menu
Basic Settings Menu
Printer Settings Menu
Network Settings Menu
System Administrator Settings Menu
Maintenance Menu
Printer Status/Print Menu

Accessing the Printer's Menus

You can use the printer menus to adjust the settings that control how your printer works.

1. Press the home button, if necessary.
2. Select Settings on the LCD screen.
   You see this screen:

3. Press the up or down arrow to scroll through the menus, or swipe up or down on the LCD screen.

   Note: To return to the previous screen, press the left arrow button.
4. Press the up or down arrow to move through the settings, or swipe up or down on the LCD screen.
5. To select a setting, select OK any time the OK option is displayed. You can also select a setting to toggle it on or off.
6. When you finish changing settings on a menu, press the left arrow button to go back or press the home button on the control panel to completely exit the menu.

**Parent topic:** Using the Control Panel Menus

## Paper Setting Menu

Select **Paper Setting** to customize paper options.

### Roll Paper menu

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove</td>
<td>—</td>
<td>Rewinds the loaded roll paper until it is ejected from the paper feeder</td>
</tr>
<tr>
<td>Feed/Cut Paper</td>
<td>Backward, Forward, Cut</td>
<td>Moves the paper backward or forward, or cuts it using the built-in cutter</td>
</tr>
<tr>
<td>Media Adjust</td>
<td>Start</td>
<td>Prints an adjustment pattern to check and adjust print quality or custom paper settings; follow the on-screen instructions</td>
</tr>
<tr>
<td>Advanced Media Setting</td>
<td>Various options</td>
<td>See the <strong>Advanced Media Setting</strong> table below</td>
</tr>
<tr>
<td>Manage Remaining Amount</td>
<td>Setup</td>
<td>Select On to display and record the amount of remaining roll paper</td>
</tr>
<tr>
<td></td>
<td>Remaining Amount</td>
<td>Select the amount increment to display (16.4 to 492 feet [5 to 150 m])</td>
</tr>
<tr>
<td></td>
<td>Remaining Alert</td>
<td>Select the amount of remaining roll paper before a warning is displayed (3.3 to 49.2 feet [1 to 15 m])</td>
</tr>
<tr>
<td>Change Paper Type</td>
<td>Paper Type</td>
<td>Select <strong>Plain Paper</strong>, <strong>Coated Paper (Generic)</strong>, or <strong>Premium Glossy Sheet</strong>. Select <strong>Others</strong> to choose another paper type.</td>
</tr>
</tbody>
</table>
### Advanced Media Setting menu (in the Roll Paper menu)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platen Gap</td>
<td>1.6, 2.1</td>
<td>Adjusts the distance between the print head and the paper; displayed when Custom Paper is selected as the Paper Type setting</td>
</tr>
</tbody>
</table>
| Top/Bottom Margins | Standard, Top 3 mm/Bottom 3 mm, Top 15 mm/Bottom 15 mm, Top 45 mm/Bottom 15 mm | The Standard margins are as follows for the top and bottom:  
  - CAD/line drawings: 3 mm  
  - Other: 30 mm  
Select a different value as necessary.  
**Note:** Left and right margins are always 3 mm. |
| Back Tension    | Auto, Standard, High, Extra High | Select High or Extra High if paper wrinkles during printing                                                                               |
| Drying Time     | Drying Time per Pass, Drying Time per Page | Select from 0 to 10 seconds for the amount of time the print head pauses to allow drying after each pass  
Select from 0 to 60 minutes for the amount of time the printer pauses to allow drying after each page is printed |
| Auto Cut        | On, Off                        | Select On to automatically cut roll paper after each page is printed, or select Off to cut paper manually                                 |

### Auto Sheet Feeder menu

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media Adjust</td>
<td>Start</td>
<td>Prints an adjustment pattern to check and adjust print quality or custom paper settings; follow the on-screen instructions</td>
</tr>
</tbody>
</table>
### Change Paper Type/Paper Size

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Paper Type/Paper Size</td>
<td>Paper Type</td>
<td>Select Plain Paper, Coated Paper (Generic), or Premium Glossy Sheet. Select Others to choose another paper type.</td>
</tr>
<tr>
<td></td>
<td>Paper Size</td>
<td>Select a paper size or select User-Defined if your desired size is not listed</td>
</tr>
</tbody>
</table>

### Cut Sheet (1 sheet) menu

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove</td>
<td>—</td>
<td>Ejects the loaded cut sheet</td>
</tr>
<tr>
<td>Media Adjust</td>
<td>Start</td>
<td>Prints an adjustment pattern to check and adjust print quality or custom paper settings; follow the on-screen instructions</td>
</tr>
<tr>
<td>Change Paper Type/Paper Size</td>
<td>Paper Type</td>
<td>Select Plain Paper, Coated Paper (Generic), or Premium Glossy Sheet. Select Others to choose another paper type.</td>
</tr>
<tr>
<td></td>
<td>Paper Size</td>
<td>Select a paper size or select User-Defined if your desired size is not listed</td>
</tr>
</tbody>
</table>

**Parent topic:** Using the Control Panel Menus

**Related tasks**
- Loading Roll Paper
- Creating Custom Paper Configurations
- Selecting the Paper Settings for Each Source - Control Panel

**Related topics**
- Cutting Roll Paper

### Basic Settings Menu

Select Settings > General Settings > Basic Settings to customize various display and power settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCD Brightness</td>
<td>1 to 9</td>
<td>Adjusts LCD screen brightness</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sound</td>
<td>Mute</td>
<td>Select On to mute control panel sounds</td>
</tr>
<tr>
<td></td>
<td>Normal Mode</td>
<td><strong>Button Press:</strong> Adjusts the volume of control panel sounds</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Error Notice:</strong> Adjusts the volume of error notifications</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Sound Type:</strong> Adjusts the type of control panel sounds</td>
</tr>
<tr>
<td>Sleep Timer</td>
<td>1 to 210 minutes</td>
<td>Selects the amount of time until the printer enters sleep mode</td>
</tr>
<tr>
<td>Power Off Timer</td>
<td>Various times</td>
<td>Selects the amount of time until the printer turns off automatically</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Circuit Breaker Interlock</td>
<td>On</td>
<td>Selects whether to turn the printer on or off when the circuit breaker switch is turned on</td>
</tr>
<tr>
<td>Startup</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Date/Time Settings</td>
<td>Date/Time</td>
<td>Enters the date and time</td>
</tr>
<tr>
<td></td>
<td>Time Difference</td>
<td>Sets the time difference for coordinated universal time (UTC)</td>
</tr>
<tr>
<td>Language</td>
<td>Various languages</td>
<td>Selects the language used on the LCD screen</td>
</tr>
<tr>
<td>Operation Time Out</td>
<td>On</td>
<td>Select On to return to the Home screen after a few minutes of inactivity</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Keyboard</td>
<td>Various settings</td>
<td>Selects the keyboard arrangement for text input screens</td>
</tr>
<tr>
<td>Length Unit</td>
<td>M</td>
<td>Selects the unit of length displayed on the LCD screen</td>
</tr>
<tr>
<td></td>
<td>ft/in</td>
<td></td>
</tr>
</tbody>
</table>

Parent topic: Using the Control Panel Menus

Related tasks
Changing the LCD Screen Language
Selecting the Date and Time
Printer Settings Menu

Select Settings > General Settings > Printer Settings to customize paper and printing options.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Source Settings</td>
<td>Various options</td>
<td>See the Paper Source Settings table below</td>
</tr>
<tr>
<td>Custom Paper Settings</td>
<td>1 to 10</td>
<td>See the Custom Paper Settings table below</td>
</tr>
<tr>
<td>Printing Language*</td>
<td>USB Network</td>
<td>Select the printing language to use for each connection mode&lt;br&gt;&lt;br&gt;<strong>Auto:</strong> select for most printing situations&lt;br&gt;<strong>HP-GL/2:</strong> select if HP-GL/2 or HP RTL print data sent from a CAD application does not automatically switch the printing mode</td>
</tr>
<tr>
<td>Universal Print Settings*</td>
<td>Various options</td>
<td>See the Universal Print Settings table below</td>
</tr>
<tr>
<td>HP-GL/2 Unique Settings</td>
<td>Various options</td>
<td>See the HP-GL/2 Unique Settings table below</td>
</tr>
<tr>
<td>Thick Paper</td>
<td>On</td>
<td>Select On to widen the platen gap to prevent scuffing if you are printing on thick paper</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Bidirectional</td>
<td>On</td>
<td>Select On if you want the print head to move left and right during printing&lt;br&gt;<strong>Off</strong> to decrease misalignment of ruled lines, but slow down printing</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>PC Connection via USB</td>
<td>Enable</td>
<td>Select Enable to allow access to the printer from a USB-connected computer</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td></td>
</tr>
<tr>
<td>USB I/F Timeout Setting</td>
<td>0.5 to 300 seconds</td>
<td>Specifies the length of time before ending communication from a USB-connected computer</td>
</tr>
</tbody>
</table>

*The Printing Language and Universal Print Settings menus can be locked by an administrator. If you cannot access or change these settings, contact your administrator for assistance.

Paper Source Settings
<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Notice</td>
<td>Paper Size Notice</td>
<td>Select <strong>On</strong> to display an error message when the output size is different</td>
</tr>
<tr>
<td></td>
<td>Paper Type Notice</td>
<td>between the driver and printer.</td>
</tr>
<tr>
<td>Roll Paper Setup</td>
<td>Detect Paper Meandering</td>
<td>Select <strong>On</strong> to display an error message and stop printing if the printer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>detects the paper is skewed.</td>
</tr>
<tr>
<td></td>
<td>Print Cutting Guideline</td>
<td>Select <strong>On</strong> to print cut lines on roll paper (if <strong>Auto Cut</strong> is turned</td>
</tr>
<tr>
<td></td>
<td></td>
<td>off).</td>
</tr>
<tr>
<td>After-Print Options</td>
<td>Hold Paper</td>
<td>Select to hold paper in the paper eject slot after printing; manually grasp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the edge of the paper and remove it from the printer to prevent it falling</td>
</tr>
<tr>
<td></td>
<td>Eject Paper</td>
<td>Select to fully eject cut sheets or automatically cut roll paper after</td>
</tr>
<tr>
<td></td>
<td></td>
<td>printing.</td>
</tr>
</tbody>
</table>

**Custom Paper Setting**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Name</td>
<td>—</td>
<td>Use the keyboard to enter a name for the custom paper setting (this name is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>displayed in the <strong>Paper Type</strong> list).</td>
</tr>
<tr>
<td>Change Reference Paper</td>
<td>Various options</td>
<td>Select the media type for the paper closest to the one you are using</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Advanced Media Setting</td>
<td>Platen Gap</td>
<td>Select a larger value if print results are smudged by print head strikes</td>
</tr>
<tr>
<td></td>
<td>Top/Bottom Margins</td>
<td>The <strong>Standard</strong> margins are as follows for the top and bottom:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• CAD/line drawings: 3 mm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Other: 30 mm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select a different value as necessary.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Left and right margins are always 3 mm.</td>
</tr>
<tr>
<td></td>
<td>Back Tension</td>
<td>Select <strong>High</strong> or <strong>Extra High</strong> if paper wrinkles during printing</td>
</tr>
<tr>
<td></td>
<td>Drying Time</td>
<td><strong>Drying Time per Pass:</strong> Select from 0 to 10 seconds for the amount of time the print head pauses to allow drying after each pass</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Drying Time per Page:</strong> Select from 0 to 60 minutes for the amount of time the printer pauses to allow drying after each page is printed</td>
</tr>
<tr>
<td></td>
<td>Auto Cut</td>
<td>Select <strong>On</strong> to automatically cut roll paper after each page is printed, or select <strong>Off</strong> to cut paper manually</td>
</tr>
<tr>
<td>Restore Default</td>
<td>—</td>
<td>Restores the custom setting to the defaults</td>
</tr>
</tbody>
</table>

**Universal Print Settings**

Adjust these settings as necessary when printing in HP-GL/2 or HP RTL mode, or when using AirPrint.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Source</td>
<td>Roll Paper</td>
<td>Select the paper source from which you want to print</td>
</tr>
<tr>
<td></td>
<td>Auto Sheet Feeder</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cut Sheet (1 sheet)</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Quality</td>
<td>Standard</td>
<td>Select the print quality</td>
</tr>
<tr>
<td></td>
<td>Speed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fine</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Super Fine</td>
<td></td>
</tr>
<tr>
<td>Color Mode</td>
<td>Color</td>
<td>Select the color you want for printing</td>
</tr>
<tr>
<td></td>
<td>Black/White</td>
<td></td>
</tr>
<tr>
<td>Page Margins option</td>
<td>Clip ByMargins</td>
<td>Adds the value selected for the page margin inside the hard clip area of the PS command of the data, or the size selected for the base output size</td>
</tr>
<tr>
<td></td>
<td>Oversize</td>
<td>Adds the value selected for the page margin outside the hard clip area of the PS command of the data (when Auto is selected)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adds the value selected for the page margin outside the size selected for the base output size (when set to a standard size)</td>
</tr>
<tr>
<td>Page Margin</td>
<td>3 mm</td>
<td>Select the top, bottom, left, and right margin values for roll paper</td>
</tr>
<tr>
<td></td>
<td>5 mm</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Margins are 3 mm for cut sheets regardless of the setting.</td>
</tr>
<tr>
<td>Smoothing</td>
<td>On</td>
<td>Select On to print at the maximum resolution for the selected paper type</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This may result in longer printing time or insufficient memory errors.</td>
</tr>
<tr>
<td>Base Output Size</td>
<td>Various options</td>
<td>When <strong>Auto</strong> (the default setting) is selected, the hard clip area of the PS command of the data becomes the base output size</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select <strong>User-Defined</strong> when printing in a custom size</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Resolution</td>
<td>Standard 300 dpi</td>
<td>Selects the print resolution; when Standard (the default setting) is selected, available resolutions depend on the selected paper type</td>
</tr>
<tr>
<td></td>
<td>600 dpi</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1200 dpi</td>
<td></td>
</tr>
<tr>
<td>Color Mode (Common)</td>
<td>EPSON Standard (sRGB)</td>
<td>Optimize the sRGB space and correct the color</td>
</tr>
<tr>
<td></td>
<td>Business Graphics</td>
<td>Perform color correction to optimize your images based on the sRGB space</td>
</tr>
<tr>
<td></td>
<td>GIS</td>
<td>Perform color correction when printing topographical maps</td>
</tr>
<tr>
<td></td>
<td>Line Drawing</td>
<td>Perform color correction when printing CAD drawings and other line drawings</td>
</tr>
<tr>
<td></td>
<td>Off (No Color Management)</td>
<td>No color correction is performed</td>
</tr>
</tbody>
</table>

**HP-GL/2 Unique Settings**

Adjust these settings as necessary when printing in HP-GL/2 or HP RTL mode.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate</td>
<td>0°</td>
<td>Rotate the coordinates of the drawn data counterclockwise before printing</td>
</tr>
<tr>
<td></td>
<td>90°</td>
<td></td>
</tr>
<tr>
<td></td>
<td>180°</td>
<td></td>
</tr>
<tr>
<td></td>
<td>270°</td>
<td></td>
</tr>
<tr>
<td>Origin Setup</td>
<td>Left Edge</td>
<td>Set the data coordinate origin</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td></td>
</tr>
<tr>
<td>Mirror Image</td>
<td>On</td>
<td>Select to horizontally flip the image using the center of the output size width as the basis line</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Select to print without flipping the image</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Line Merge</td>
<td>On</td>
<td>Select to merge the intersection of overlapping lines within the image according to the MC command of the data</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Select to move lines to be printed later to the front at intersections</td>
</tr>
<tr>
<td>Color Mode (HP-GL/2)</td>
<td>EPSON Standard (sRGB)</td>
<td>Optimize the sRGB space and correct the color</td>
</tr>
<tr>
<td></td>
<td>Business Graphics</td>
<td>Perform color correction to optimize your images based on the sRGB space</td>
</tr>
<tr>
<td></td>
<td>GIS</td>
<td>Perform color correction when printing topographical maps</td>
</tr>
<tr>
<td></td>
<td>Line Drawing</td>
<td>Perform color correction when printing CAD drawings and other line drawings</td>
</tr>
<tr>
<td></td>
<td>Off (No Color Management)</td>
<td>No color correction is performed</td>
</tr>
<tr>
<td>Select Palette</td>
<td>Software</td>
<td>Print according to the pen configurations set in the application and ignore the built-in printer palette</td>
</tr>
<tr>
<td></td>
<td>Default</td>
<td>Print according to the built-in printer palette settings (logical pen with a pen width of 0.35 mm and 256 colors)</td>
</tr>
<tr>
<td></td>
<td>Palette A</td>
<td>Print according to the built-in printer palette settings specified under Define Palette</td>
</tr>
<tr>
<td></td>
<td>Palette B</td>
<td></td>
</tr>
<tr>
<td>Print Color Palette</td>
<td>Print</td>
<td>Print the palette settings selected in Select Palette in A3 size</td>
</tr>
<tr>
<td>Define Palette</td>
<td>Palette A</td>
<td>Define a built-in palette by specifying the pen width and color for the 16 types of logical pens</td>
</tr>
<tr>
<td></td>
<td>Palette B</td>
<td></td>
</tr>
<tr>
<td>Restore Default HP-GL/2</td>
<td>No</td>
<td>Select Yes to restore all HP-GL/2 Unique Settings to their defaults</td>
</tr>
<tr>
<td>Unique Settings</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

Parent topic: Using the Control Panel Menus
Related tasks
Creating Custom Paper Configurations
Selecting the Paper Settings for Each Source - Control Panel
Printing CAD Drawings in HP-GL/2 or HP RTL Mode

Network Settings Menu
Select Settings > General Settings > Network Settings to configure your printer's network settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wi-Fi Setup</td>
<td>Router</td>
<td>See the link below for more information</td>
</tr>
<tr>
<td></td>
<td>Wi-Fi Direct</td>
<td></td>
</tr>
<tr>
<td>Wired LAN Setup</td>
<td>—</td>
<td>See the link below for more information</td>
</tr>
<tr>
<td>Network Status</td>
<td>Wired LAN/Wi-Fi Status</td>
<td>Displays current communication status and connection settings</td>
</tr>
<tr>
<td></td>
<td>Wi-Fi Direct Status</td>
<td>Displays the number of connected devices and connection settings</td>
</tr>
<tr>
<td></td>
<td>Print Status Sheet</td>
<td>Prints the current network connection information</td>
</tr>
<tr>
<td>Connection Check</td>
<td>—</td>
<td>Confirms the network status. You can also print a connection check report.</td>
</tr>
<tr>
<td>Advanced</td>
<td>—</td>
<td>Displays advanced information, such as TCP/IP settings. You can enable or disable other network settings.</td>
</tr>
</tbody>
</table>

Parent topic: Using the Control Panel Menus

System Administrator Settings Menu
Select Settings > General Settings > System Administrator Settings to configure security settings and update firmware.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Settings</td>
<td>Admin Settings</td>
<td>Lets you add or change the administrator password. If you choose to add a password, set the <strong>Lock Setting</strong> to <strong>On</strong> to enable password entry for certain features and settings.</td>
</tr>
<tr>
<td>Restore Default Settings</td>
<td>Network Settings</td>
<td>Select <strong>Yes</strong> to restore all network settings to their defaults.</td>
</tr>
<tr>
<td></td>
<td>Clear All Data and Settings</td>
<td>Select <strong>Yes</strong> to restore all settings to their defaults (except date/time, length unit, and language settings)</td>
</tr>
<tr>
<td>Firmware Update</td>
<td>Update</td>
<td>Select <strong>Start Checking</strong> to access the Epson website and search for a firmware update. The printer must be connected to the internet. Follow the prompts to update the firmware, which can take up to 5 minutes. <strong>Note:</strong> Do not turn off or unplug the printer during a firmware update or you may damage the printer. Select <strong>On</strong> to allow the printer to automatically check for new firmware; a message is displayed on the LCD screen if new firmware is found.</td>
</tr>
</tbody>
</table>

Parent topic: Using the Control Panel Menus

Related tasks

- Setting a Password and Locking the Control Panel
**Maintenance Menu**

Select **Settings > Maintenance** to run nozzle checks, cleaning cycles, and other maintenance operations.

**Caution:** Follow the instructions in the topic links below the table to use these menu settings correctly.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print Quality Adjustment</strong></td>
<td>Perform when there are streaks in printouts, ruled lines are duplicated, or text is blurred</td>
</tr>
<tr>
<td><strong>Print Head Nozzle Check</strong></td>
<td>Prints a nozzle check pattern so you can check for clogged nozzles</td>
</tr>
<tr>
<td><strong>Head Cleaning</strong></td>
<td>Perform if the nozzle check pattern has faint or missing areas</td>
</tr>
<tr>
<td><strong>Paper Guide Cleaning</strong></td>
<td>Perform if printouts are smeared when printing from the auto sheet feeder</td>
</tr>
<tr>
<td><strong>Ink Cartridge(s) Replacement</strong></td>
<td>Moves the print head to the correct position so you can replace ink cartridges. Displays the ink cartridge replacement procedure.</td>
</tr>
<tr>
<td><strong>Replace Maintenance Box</strong></td>
<td>Displays the maintenance box replacement procedure</td>
</tr>
<tr>
<td><strong>Replace Cutter</strong></td>
<td>Displays the cutter replacement procedure</td>
</tr>
<tr>
<td><strong>Powerful Cleaning</strong></td>
<td>Perform if the nozzle check pattern still has faint or missing areas after performing a head cleaning three times in a row</td>
</tr>
<tr>
<td><strong>Discharging/Charging Ink</strong></td>
<td>Perform if you are transporting or storing the printer in 14°F (~10°C) or lower temperatures. Follow the prompts to eject the ink. The printer turns off automatically after the procedure.</td>
</tr>
</tbody>
</table>

*The **Powerful Cleaning** and **Discharging/Charging Ink** settings can be locked by an administrator. If you cannot access or change these settings, contact your administrator for assistance.

**Parent topic:** Using the Control Panel Menus

**Related tasks**
- Checking the Nozzles Using the Product Control Panel
- Cleaning the Print Head Using the Product Control Panel
- Using the Powerful Cleaning Utility
- Adjusting Print Quality Using the Product Control Panel
Printer Status/Print Menu

Select Settings > Printer Status/Print to view current printer and network settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Status Sheet</td>
<td>Configuration Status Sheet</td>
<td>Prints a summary of current printer settings</td>
</tr>
<tr>
<td>Network</td>
<td>Wired LAN/Wi-Fi Status</td>
<td>Displays current communication status and connection settings</td>
</tr>
<tr>
<td></td>
<td>Wi-Fi Direct Status</td>
<td>Displays the number of connected devices and connection settings</td>
</tr>
<tr>
<td>Print Status Sheet</td>
<td></td>
<td>Prints the current network connection information</td>
</tr>
</tbody>
</table>

Parent topic: Using the Control Panel Menus
Replacing Ink Cartridges and Maintenance Boxes

If a message appears or the ⚠ icon appears above an ink color on the LCD screen, the cartridge is low or expended. When an ink cartridge is expended, printing stops and you need to replace the cartridge. You may also need to replace a cartridge that is more than six months old, or if your printouts do not look their best, even after cleaning and aligning the print head.

The maintenance box stores ink that gets flushed from the system during print head cleaning. If a message appears or the ⚠ icon appears above the maintenance box icon on the LCD screen, the amount of empty space in the maintenance box is low. When the maintenance box is full, you need to replace it.

**Note:** Please dispose of your used Epson branded ink cartridges responsibly and in accordance with local requirements. If you would like to return your used ink cartridges to Epson for proper disposal, please go to epson.com/recycle for more information.

Check Cartridge and Maintenance Box Status
Purchase Epson Ink Cartridges and Maintenance Box
Removing and Installing Ink Cartridges
Replacing the Maintenance Box

Check Cartridge and Maintenance Box Status

Your product and its software will let you know when an ink cartridge is low or expended, or when the maintenance box needs to be replaced.

Checking Ink Cartridge and Maintenance Box Status on the LCD Screen
Checking Ink Cartridge and Maintenance Box Status with Windows
Checking Cartridge and Maintenance Box Status - Mac

**Parent topic:** Replacing Ink Cartridges and Maintenance Boxes

Checking Ink Cartridge and Maintenance Box Status on the LCD Screen

When one of your ink cartridges is low or expended, or the maintenance box is almost full, you see a message on the LCD screen.

You can also check the status of the ink cartridges and maintenance box from the product control panel. If the ⚠ icon appears on an ink color or the maintenance box, you need to replace them soon.

1. Press the home button, if necessary.
2. Do one of the following:
   • Select the ink color icons at the top of the home screen.
   • Select **Printer Status > Supply Status**.
   You see a screen like this:

![Supply Status Screen]

**Note:** The displayed ink and maintenance box levels are approximate.

**Parent topic:** Check Cartridge and Maintenance Box Status

**Related tasks**
- Removing and Installing Ink Cartridges
- Replacing the Maintenance Box

**Checking Ink Cartridge and Maintenance Box Status with Windows**

You can check your ink cartridge or maintenance box status at any time using a utility on your Windows computer.

1. To check your status, access the Windows Desktop and click the icon for your product in the right side of the Windows taskbar, or click the up arrow and click . Then click your product name.
You see a screen like this:

![EPSON Status Monitor screenshot](image)

2. Replace or reinstall the ink cartridge or maintenance box as indicated on the screen.

   **Note:** If any of the ink cartridges installed in the product is broken, incompatible with the product model, or improperly installed, Epson Status Monitor will not display an accurate ink status.

**Parent topic:** Check Cartridge and Maintenance Box Status

**Related tasks**
- [Removing and Installing Ink Cartridges](#)
- [Replacing the Maintenance Box](#)

### Checking Cartridge and Maintenance Box Status - Mac

You can check the status of your ink cartridges and maintenance box using a utility on your Mac.

1. In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.

2. Select **EPSON Status Monitor**.
You see this window:

![EPSON Status Monitor](image)

3. Do the following as necessary:
   - You can update the ink cartridge and maintenance box status by clicking **Update**.
   - Replace or reinstall the maintenance box or any ink cartridge as indicated on the screen.

   **Note:** If any of the cartridges installed in the product is broken, incompatible with the product model, or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

**Parent topic:** Check Cartridge and Maintenance Box Status

**Related tasks**
- Removing and Installing Ink Cartridges
- Replacing the Maintenance Box

**Purchase Epson Ink Cartridges and Maintenance Box**

You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com (U.S. sales), epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from
an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

**Note:** We recommend that you use genuine Epson maintenance boxes and cartridges and do not refill them. The use of other products may affect your print quality and could result in printer damage.

Part of the ink from the included set of cartridges is used for charging the printer. Yields vary considerably based on images printed, print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink remains in the cartridge after the "replace cartridge" indicator comes on.

**Ink Cartridge and Maintenance Box Part Numbers**

**Parent topic:** Replacing Ink Cartridges and Maintenance Boxes

### Ink Cartridge and Maintenance Box Part Numbers

Use these part numbers when you order or purchase a new ink cartridge or maintenance box.

**Note:** For best printing results, use up a cartridge within 6 months of opening the package.

Maintenance box part number: C13S210057

<table>
<thead>
<tr>
<th>Ink color</th>
<th>26 ml</th>
<th>50 ml</th>
<th>80 ml</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>—</td>
<td>T40V120</td>
<td>T40W120</td>
</tr>
<tr>
<td>Cyan</td>
<td>T40V220</td>
<td>T40W220</td>
<td>—</td>
</tr>
<tr>
<td>Magenta</td>
<td>T40V320</td>
<td>T40W320</td>
<td>—</td>
</tr>
<tr>
<td>Yellow</td>
<td>T40V420</td>
<td>T40W420</td>
<td>—</td>
</tr>
</tbody>
</table>

**Parent topic:** Purchase Epson Ink Cartridges and Maintenance Box

### Removing and Installing Ink Cartridges

Make sure you have your replacement cartridges handy before you begin. You must install new cartridges immediately after removing the old ones.

**Note:** Replace all expended ink cartridges. You cannot print if any of the ink cartridges are expended or any ink slots are empty.
1. Turn on your product.
2. Select **Settings > Maintenance > Ink Cartridge(s) Replacement > Start**.
3. Open the front cover.

4. Press the tab on the ink cartridge cover and lift to open the cover.

5. Push in the tab at the top of the ink cartridge and pull it out.
Note: Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away. Keep ink cartridges out of the reach of children.

6. Gently shake the new ink cartridge for about 10 seconds.

7. Remove the cartridge from the package and peel off the yellow tape.

Caution: Do not remove any other labels or seals, or ink may leak. Do not touch the areas on the ink cartridge as shown below.
8. Insert the new cartridge and push it in firmly.

9. Repeat steps 6 to 8 as necessary to replace any other cartridges.
10. Close the ink cartridge cover and the front cover.

Your product begins charging the ink delivery system. A message appears on the LCD screen when ink replacement is complete.

**Note:** Do not open any covers or turn off the product during ink charging.

**Caution:** If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the printer. The valve in the ink supply port is designed to contain any excess ink, but do not touch the ink supply port or surrounding area. Always store ink cartridges with the label facing up; do not store cartridges upside-down.

**Parent topic:** Replacing Ink Cartridges and Maintenance Boxes

**Related concepts**

- Purchase Epson Ink Cartridges and Maintenance Box

**Replacing the Maintenance Box**

Replace the maintenance box when a message is displayed on the LCD screen telling you that the maintenance box is near or at the end of its service life.

**Note:** You can view the replacement procedure on the LCD screen. Press the home button if necessary and select **Settings > Maintenance > Replace Maintenance Box > See Guide.**
1. Open the maintenance box cover on the back of the product.

2. Pull out the maintenance box carefully without tilting it.

   Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.

3. Remove the new maintenance box from the package.

   Caution: Do not touch the chip on the side of the maintenance box or you may damage the product.
4. Align the groove on the maintenance box with the rails inside the product and insert it fully.

5. Place the used maintenance box in the bag supplied with the new box and seal the bag.

**Note:** Dispose of the used maintenance box carefully.

6. Close the maintenance box cover.

**Parent topic:** Replacing Ink Cartridges and Maintenance Boxes

**Related concepts**

Purchase Epson Ink Cartridges and Maintenance Box

**Related references**

Optional Equipment and Replacement Parts
Adjusting Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

If running these utilities does not solve the problem, you may need to replace the ink cartridges.

- **Print Head Maintenance**
- **Adjusting Print Quality Using the Product Control Panel**
- **Cleaning the Auto Sheet Feeder**
- **Cleaning the Roll Paper Feeder**

**Print Head Maintenance**

If your printouts become too light, or you see dark or light bands across them, you may need to clean the print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

**Note:** You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it when a cartridge is low. You must replace the cartridge first.

- **Print Head Nozzle Check**
- **Print Head Cleaning**

**Parent topic:** [Adjusting Print Quality](#)

**Related tasks:**
- [Removing and Installing Ink Cartridges](#)

**Print Head Nozzle Check**

You can print a nozzle check pattern to check for clogged nozzles.

- **Checking the Nozzles Using the Product Control Panel**
- **Checking the Nozzles Using a Computer Utility**
Parent topic: Print Head Maintenance

Checking the Nozzles Using the Product Control Panel

You can check the print head nozzles using the control panel on your product.

1. Make sure roll paper or cut sheet paper is loaded in the printer.
2. Press the home button, if necessary.
3. Select Settings > Maintenance > Print Head Nozzle Check. You see a screen like this:

![Print Head Nozzle Check screen]

Choose paper source to print the nozzle check pattern and touch Start.
Current paper source: Roll Paper

4. If you want to change the paper source that the nozzle check pattern prints on, select Paper Source. Otherwise, select Start to print the nozzle check pattern.

The nozzle check pattern prints.
5. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean pattern]

   **Print head needs cleaning**

   ![Print head needs cleaning pattern]

6. Do one of the following:
   
   - If there are no gaps in the pattern, select the icon.
   - If there are gaps or the pattern is faint, select the icon on the Head Cleaning screen. Select **Start** to clean the print head.

   If you don’t see any improvement after cleaning the print head three times, perform a **Powerful Cleaning**.

   **Parent topic:** Print Head Nozzle Check

   **Related tasks**
   - Checking the Nozzles Using a Computer Utility
   - Cleaning the Print Head Using the Product Control Panel
   - Using the Powerful Cleaning Utility

   **Checking the Nozzles Using a Computer Utility**

   You can check the print head nozzles using a utility on your Windows or Mac computer.

   1. Make sure roll paper or cut sheet paper is loaded in the printer.
   2. Do one of the following:

      - **Windows:** Access the Windows Desktop and click the icon for your product in the right side of the Windows taskbar, or click the up arrow and click .
• **Mac**: In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.

3. Select **Nozzle Check**.

   You see a window like this:

   ![Nozzle Check window](image)

   To perform a nozzle check, make sure that the printer is on and connected to the computer. Also, make sure that roll paper or one sheet of A4/Letter size or larger paper is loaded in the printer. Click [Print] to print a nozzle check pattern or click [Cancel] to quit.

4. Click **Print**.

   The nozzle pattern prints.
5. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean pattern]

   **Print head needs cleaning**

   ![Print head needs cleaning pattern]

6. If there are no gaps in the pattern, click **Finish**.
   
   If there are gaps or the pattern is faint, click **Clean**.

   If you don’t see any improvement after cleaning the print head three times, perform a **Powerful Cleaning**.

   **Parent topic:** Print Head Nozzle Check

   **Related tasks**

   - Checking the Nozzles Using the Product Control Panel
   - Cleaning the Print Head Using a Computer Utility
   - Using the Powerful Cleaning Utility

**Print Head Cleaning**

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the print head.

**Note:** You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it when a cartridge is low. You must replace the cartridge first.

   - Cleaning the Print Head Using the Product Control Panel
   - Cleaning the Print Head Using a Computer Utility
   - Using the Powerful Cleaning Utility
Cleaning the Print Head Using the Product Control Panel

You can clean the print head using the control panel on your product.

1. Make sure roll paper or cut sheet paper is loaded in the printer.
2. Press the home button, if necessary.
3. Select Settings > Maintenance > Head Cleaning.
   You see a screen like this:

![Head Cleaning Screen]

4. Select Start to begin the cleaning cycle.
   When the cleaning cycle is finished, the power light stops flashing and a confirmation screen appears.
   **Caution:** Never open any covers or turn off the product during a cleaning cycle or you may damage it.

5. Select Yes to print a nozzle check pattern.
   The nozzle pattern prints.
6. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean pattern](image)

   **Print head needs cleaning**

   ![Print head needs cleaning pattern](image)

7. Follow the instructions on the screen to clean the print head, check the nozzles, and repeat the process as necessary.

   If you don’t see any improvement after cleaning the print head three times, perform a **Powerful Cleaning**.

   **Parent topic:** Print Head Cleaning

   **Related tasks**

   - Cleaning the Print Head Using a Computer Utility
   - Checking the Nozzles Using the Product Control Panel
   - Using the Powerful Cleaning Utility

**Cleaning the Print Head Using a Computer Utility**

You can clean the print head using a utility on your Windows computer or Mac.

1. Make sure roll paper or cut sheet paper is loaded in the printer.

2. Do one of the following:

   - **Windows:** Access the Windows Desktop and click the icon for your product in the right side of the Windows taskbar, or click the up arrow and click .
   - In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.

3. Select **Head Cleaning**.
You see a window like this:

4. Click **Start** to begin the cleaning cycle. When the cleaning cycle is finished, the power light stops flashing and a confirmation screen appears.

   **Caution:** Never open any covers or turn off the product during a cleaning cycle or you may damage it.

5. Click **Print Nozzle Check Pattern**. The nozzle pattern prints.
6. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean pattern]

   **Print head needs cleaning**

   ![Print head needs cleaning pattern]

If you don’t see any improvement after cleaning the print head three times, perform a **Powerful Cleaning**.

**Parent topic:** Print Head Cleaning

**Related tasks**
- Cleaning the Print Head Using the Product Control Panel
- Checking the Nozzles Using a Computer Utility
- Using the Powerful Cleaning Utility

**Using the Powerful Cleaning Utility**

If print head nozzles are still clogged after cleaning the print head three times, run the **Powerful Cleaning** utility from the product control panel. This process consumes a lot of ink to clean the clogged nozzles.

1. Press the home button, if necessary.
2. Select Settings > Maintenance > Powerful Cleaning.
You see a screen like this:

3. Select **Start** to begin the cleaning cycle.
   When the cleaning cycle is finished, the ⚡ power light stops flashing and a confirmation screen appears.

   **Caution:** Never open any covers or turn off the product during a cleaning cycle or you may damage it.

4. Select **Yes > Start** to print a nozzle check pattern.
   The nozzle pattern prints.
5. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean pattern]

   **Print head needs cleaning**

   ![Print head needs cleaning pattern]

   If nozzles are still clogged, turn off the printer and leave it off overnight. If nozzles are still clogged, contact Epson for support.

   **Parent topic:** Print Head Cleaning

   **Related tasks**

   - Checking the Nozzles Using the Product Control Panel
   - Checking the Nozzles Using a Computer Utility
   - Cleaning the Print Head Using the Product Control Panel
   - Cleaning the Print Head Using a Computer Utility

### Adjusting Print Quality Using the Product Control Panel

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or light horizontal bands, you may need to adjust print quality using the product control panel.

1. Make sure roll paper or cut sheet paper is loaded in the printer. You need at least this much paper to print the adjustment pattern:
   - Roll paper: 16.5 inches (420 mm)
   - Auto sheet feeder: 2 sheets of paper sized A3 (11.7 × 16.5 inches [297 × 420 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm])
   - Cut sheet feeder: 1 sheet of paper sized A2 (16.5 × 23.4 inches [420 × 594 mm]) or larger, or 2 sheets of paper smaller than A2 (16.5 × 23.4 inches [420 × 594 mm]), loaded one at a time
2. Press the \(\text{Home}\) home button, if necessary.
3. Make sure the correct paper type is selected on the product control panel.

4. Select **Settings > Maintenance > Print Quality Adjustment**.
   You see a screen like this:

   ![Screen shot of Media Adjust](image)

   Choose paper source to print the alignment pattern and touch Start.
   Current paper source: Roll Paper
   - Paper Source
   - Start

5. If you want to change the paper source that the adjustment pattern prints on, select **Paper Source**. Otherwise, select **Start** to print the adjustment pattern.
   The first set of adjustment patterns prints.
   **Note:** If you are printing on cut sheets in A2 (16.5 × 23.4 inches [420 × 594 mm]) size or larger, or on roll paper with **Auto Cut** turned off, do not remove or pull out the paper until the second set of alignment patterns prints.

6. Follow the instructions on the LCD screen to select the best patterns for the first set of adjustment patterns, and select **OK**.
   The second set of adjustment patterns prints.
   **Note:** If you are printing on cut sheets smaller than A2 (16.5 × 23.4 inches [420 × 594 mm]) size, load the second sheet of paper.

7. Follow the instructions on the LCD screen to select the best patterns for the second set of adjustment patterns, and select **OK**.
   The screen displays a confirmation message and returns to the home screen.

**Parent topic:** Adjusting Print Quality
Cleaning the Auto Sheet Feeder

If ink smears on a printout when printing from the auto sheet feeder (especially on glossy paper), you can clean the auto sheet feeder roller to remove excess ink.

**Note:** If ink smears when printing on glossy paper, we recommend printing individual cut sheets one at a time instead of using the auto sheet feeder.

1. Load a few sheets of plain paper in the auto sheet feeder.
2. Press the home button, if necessary.
3. Select **Settings** > **Maintenance** > **Paper Guide Cleaning**.
   
   You see a screen like this:

   ![Paper Guide Cleaning Screen](image)

   **Load paper into the auto sheet feeder to clean the roller.**

   ![Start Button](image)

   **Start**

4. Select **Start** to clean the paper guide.
   
   The paper is ejected.

5. Check the ejected paper to see if it is clean.
   
   - If you see ink smears, press and hold **Run Again**. Repeat until there is no more ink on the ejected paper.
   
   - If there is no ink visible, select **Done**.

**Parent topic:** Adjusting Print Quality

**Related tasks**

Loading Paper in the Auto Sheet Feeder
Cleaning the Roll Paper Feeder

If ink smears on a printout when printing on roll paper or cut sheets, you can clean the roll paper feeder to remove excess ink.

1. Make sure roll paper is loaded in the printer.
2. Press the home button, if necessary.
4. Press and hold 'Forward' until there are no ink smears on the ejected roll paper.
5. Select 'Cut' to cut the roll paper.

Parent topic: Adjusting Print Quality
Related tasks
Loading Roll Paper
Maintenance and Transportation

See the instructions in these sections to maintain your printer for optimum results, or to move or transport your printer.

Replacing the Cutter
Moving or Transporting Your Product

Replacing the Cutter

If you notice that your paper does not cut cleanly, you may need to replace the cutter. You will need a Phillips-head screwdriver.

Caution: Do not remove the protective material from the new cutter until instructed to do so. Do not drop the cutter or knock it against anything or you may chip the blade.

1. Press the home button, if necessary.
2. Select Settings > Maintenance > Replace Cutter > Start.
3. Open the cutter cover.

Caution: Do not remove the protective material from the new cutter until instructed to do so. Do not drop the cutter or knock it against anything or you may chip the blade.
4. Use a Phillips-head screwdriver to loosen the screw holding the cutter in place and carefully remove the cutter. Place the cutter in a plastic bag and dispose of it properly.

**Warning:** Keep the cutter out of the reach of children. The blade is sharp and can cause injury.
5. Align the pins on the new cutter with the holes in the product and insert the cutter. Tighten the cutter screw securely.

**Note:** Make sure the screw is tightened securely, otherwise the cut position may be slightly shifted or skewed.

6. Remove only the protective material from the cutter shown here.
Note: Do not remove the protective piece shown here.

7. Select OK. The cutter moves into position and cuts off the protective piece. Remove the protective piece from the printer.
8. Close the cutter cover.

Parent topic: Maintenance and Transportation
Related references
Optional Equipment and Replacement Parts

Moving or Transporting Your Product

If you need to move or transport your product, prepare it as described here.

Caution: During transportation and storage, follow these guidelines:
• Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.
• Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent the product from printing, or ink may leak.

Note: Before storing your product for a long period, replace low, expended, or expired ink to help prevent the print head from drying out. Store your product in a cool, dry place.

1. Remove all the paper from the product.
2. Turn off the product.
3. Unplug the power cable.
4. Disconnect any connected cables.
5. Remove the output tray, if necessary.
6. Close all covers on the product.
7. For a product without a stand, have at least two people lift the product using the indented areas as shown.

![Image of lifting the product](image)

**Warning:** The product is heavy and requires two or more people to move it.

8. For a product with a stand, do the following:
   - Close the paper basket.
   - Release the caster locks.
   - Move the product on an even floor surface.
   - Lock the casters after the product has been moved.

**Caution:** Do not move the product with locked casters. Avoid areas with steps or uneven flooring.

**Note:** If you are transporting or storing the product below 14°F (–10°C), you must discharge the ink. See the link below for instructions.

9. Place the product in its original packing materials, if possible, or use equivalent materials with cushioning around the product.
10. After the printer is moved, connect the power cable and turn on the printer.
11. Run a print head nozzle check and clean the print head, if necessary.

**Discharging Ink**

**Parent topic:** Maintenance and Transportation

**Related concepts**

Print Head Nozzle Check
Print Head Cleaning

Discharging Ink

If you need to move or transport your product when the temperature is 14°F (–10°C) or lower, you must first discharge the ink to keep the print head in optimum condition.

Note: The maintenance box needs enough capacity to discharge the ink. Replace the maintenance box first if the remaining capacity is low.

1. Turn on the product.
2. Remove all the paper from the product.
3. Press the home button, if necessary.
   The ink cartridges move to the replacement position.
5. Open the front cover.
6. Open the ink cartridge cover, remove all the ink cartridges, and set them aside.
7. Close the ink cartridge cover and front cover.
   The ink begins to discharge.
Caution: Do not open the cover or turn off the product while ink is discharging.

8. When a message appears on the LCD screen, open the front cover and the ink cartridge cover again.

9. Reinsert all the ink cartridges.

10. Close the ink cartridge cover and the front cover.
    The product automatically turns off.

Parent topic: Moving or Transporting Your Product
Related tasks
Checking Ink Cartridge and Maintenance Box Status on the LCD Screen
Solving Problems

Check these sections for solutions to problems you may have using your product.

Checking for Software Updates
Product Status Messages
Resetting Control Panel Defaults
Solving Printer Problems
Solving Network Problems
Solving Printing Problems
Solving Paper Problems
Solving Print Quality Problems
Cannot Make Enlarged Copies from Scanner
Uninstall Your Product Software
Where to Get Help

Checking for Software Updates

Periodically, it's a good idea to check Epson's support website for free updates to your product software. Visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

- **Windows**: Your printer software automatically checks for updates. You can also manually update the software by selecting **Software Update** here:
  
  - Access the Windows Desktop and right-clicking the 🖼️ icon for your product in the right side of the Windows taskbar, or clicking the up arrow and right-clicking 🖼️.
  
  - On the **Maintenance** tab in the printer settings window
  
  You can also update the software by selecting **EPSON Software Updater** in the **EPSON** or **EPSON Software** program group, accessible by the **Start** button, or on the **Start** or **Apps** screens, depending on your version of Windows.

- **OS X**: You can manually update the software by opening the **Applications > Epson Software** folder and selecting **EPSON Software Updater**.

- **macOS 10.12.x or 10.13.x**: You can manually update the software by opening the **App Store**, selecting **Updates**, searching for a software update option for Epson Software, and selecting **Update**.

Parent topic: Solving Problems
# Product Status Messages

You can often diagnose problems with your product by checking the messages on the LCD screen.

<table>
<thead>
<tr>
<th>LCD screen message</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot recognize ink cartridges. Try installing again.</td>
<td>Remove and reinsert the ink cartridge. If the message persists, insert a new ink cartridge. Make sure the ink cartridges are at room temperature. Make sure you are using genuine Epson ink cartridges.</td>
</tr>
<tr>
<td>Ink is low.</td>
<td>The ink is low. Make sure you have a replacement ink cartridge handy.</td>
</tr>
<tr>
<td>The maintenance box is not recognized. Install it correctly.</td>
<td>Remove and reinsert the maintenance box. If the message persists, insert a new maintenance box.</td>
</tr>
<tr>
<td>There is not enough space in maintenance box to perform head cleaning. You can continue printing until replacement is required.</td>
<td>The maintenance box does not have enough capacity to store ink discharged in print head cleaning. Do not perform head cleaning until you replace the maintenance box with a new one. The used maintenance box may be reinstalled after cleaning is completed.</td>
</tr>
<tr>
<td>Command Error Check the printer driver setting.</td>
<td>Select <strong>Cancel</strong> to stop printing. Make sure that the printer driver you are using supports your product.</td>
</tr>
<tr>
<td>Scanner Error Refer to manual for details.</td>
<td>Release the scanner transportation lock as described in your scanner's <em>User’s Guide</em>. Turn the printer and scanner off and on. If the message persists, contact Epson for support.</td>
</tr>
<tr>
<td>Recovery Mode</td>
<td>The printer restarted in recovery mode because the firmware update failed. Make sure the computer and printer are connected via USB and try updating the firmware again.</td>
</tr>
<tr>
<td>Maintenance Request Replace Parts Soon/End of Parts Service Life (maintenance request code)</td>
<td>A part used in the printer is nearing or at the end of its service life. Contact Epson for support and provide them with the displayed maintenance request code. The error persists until you replace the requested part.</td>
</tr>
<tr>
<td>LCD screen message</td>
<td>Condition/solution</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Printer Error</td>
<td>Turn off the printer, disconnect the power cable from the outlet and from the printer, and reconnect it. Turn on the printer again. If the message persists, contact Epson for support and provide them with the displayed printer error code.</td>
</tr>
<tr>
<td>Printer error. Turn the power off and on again. If the problem persists, contact Epson Support. (printer error code)</td>
<td></td>
</tr>
</tbody>
</table>

**Parent topic:** Solving Problems

**Related references**

Where to Get Help

**Related tasks**

Removing and Installing Ink Cartridges
Replacing the Maintenance Box
Connecting a Scanner to Your Printer

## Resetting Control Panel Defaults

If you have a problem with settings on the product control panel, you can reset them to their factory defaults. You can choose which settings to reset or reset them all.

**Note:** This setting can be locked by an administrator. If you cannot access or change this setting, contact your administrator for assistance.

1. Press the home button, if necessary.
2. Select Settings > General Settings > System Administration > Restore Default Settings.
You see a screen like this:

![Screen with options]

3. Select one of these options:
   - **Network Settings**: Resets all network settings.
   - **Clear All Data and Settings**: Resets all control panel settings except date and time, length unit, and language settings.

   You see a confirmation screen.

4. Select **Yes** to reset the selected settings. (Select **No** if you want to cancel the operation.)

   **Parent topic**: Solving Problems

---

### Solving Printer Problems

Check these sections if you have problems operating your product.

- **Printer Does Not Turn On**
- **LCD Screen Shuts Off**

   **Parent topic**: Solving Problems

---

### Printer Does Not Turn On

If the printer does not turn on, try these solutions:

- Make sure the power cable is securely connected.
- Make sure the power outlet works by connecting the power cable for another electronic device.
LCD Screen Shuts Off

If the LCD screen shuts off intermittently, the printer may be in sleep mode. Try these solutions:

• Press any of the buttons on the control panel to exit sleep mode.
• You can adjust the delay time before the product enters sleep mode in the Basic Settings menu.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not responsible for backing up or recovering data and settings during or after the warranty period. We recommend that you make your own backup or print out your network data and settings.

Product Cannot Connect to a Wireless Router or Access Point

If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product's LCD screen is not lit or does not appear, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.

• Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

- Verify that your router or access point is operating correctly by connecting to it from your computer or another device.
- You may need to disable the firewall and any anti-virus software on your wireless router or access point.
- Check to see if access restrictions, such as MAC address filtering, are set on the router or access point. If access restrictions are set, add your product's MAC address to your router's address list. To obtain your product's MAC address, print a network status sheet. Then follow the instructions in your router or access point documentation to add the address to the list.
- If your router or access point does not broadcast its network name (SSID), follow the instructions that came with your product to enter your wireless network name manually.
- If your router or access point has security enabled, determine the kind of security it is using and any required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA passphrase correctly.
- Check if your computer is restricting the available wireless channels. If so, verify that your wireless access point is using one of the usable channels and change to a usable channel, if necessary.
- If you cannot connect your product to a device using Wi-Fi Direct, you may have exceeded the maximum number of devices connected to your product (4). Print a network status sheet or access Web Config on the browser for your device and check the number of connected devices. If 4 devices are already connected, disconnect a device by deleting the product's SSID from the Wi-Fi screen of that device. If fewer than 4 devices are connected, check the accuracy of your other network settings, move your device closer to your product, and try connecting again.
- If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection settings from your device and enter a new password. See your device documentation for instructions.
- If you connected your product to a Windows computer using Wi-Fi Direct and it automatically selected Access Point Mode, you may have trouble accessing a low-priority Internet connection. Check the network connection or adapter settings in the Windows Control Panel and set the Internet metric setting to 100 for your version of the Internet Protocol.

Parent topic: Solving Network Problems
Network Software Cannot Find Product on a Network

If EpsonNet Setup cannot find your product on a network, try these solutions:

• Make sure your product is turned on and connected to your network. Verify connection using your product control panel.

• Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-ASCII characters.

• Make sure your product is not connected to a guest network.

• If necessary, reinstall your product software and try running EpsonNet Setup again:
  1. Reset your product's network settings to their factory defaults.
  2. **Windows only:** Uninstall your product software.
  3. Initialize your router following the instructions in your router documentation.

   **Note:** If you are reading these instructions online, you will lose your Internet connection when you initialize your router, so note the next step before initializing it.

  4. Download your product software from the Epson website using the instructions on the *Start Here* sheet.

• If you have replaced your router, reinstall your product software to connect to the new router.

  **Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

• Check to see if your wireless router or access point has an enabled Privacy Separator function that is preventing detection of your device over the network. See your router or access point documentation for instructions on disabling the Privacy Separator function.

Parent topic: Solving Network Problems

Related concepts

Uninstall Your Product Software

Related tasks

Resetting Control Panel Defaults
Product Does Not Appear in Mac Printer Window

If your product does not appear in the Mac printer window, try these solutions:

• Turn your product off, wait 30 seconds, then turn it back on again.
• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product's LCD screen is not lit, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.
• If you are connecting the product wirelessly via EpsonNet Setup and the Wi-Fi icon does not appear lit on your LCD screen, make sure your product software was installed correctly. If necessary, reinstall your software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

Parent topic: Solving Network Problems

Cannot Print Over a Network

If you cannot print over a network, try these solutions:

• Make sure that your product is turned on.
• Make sure you install your product's network software as described in your product documentation.
• Print a network status sheet and verify that the network settings are correct. If the network status is Disconnected, check any cable connections and turn your product off and then on again.
• If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your network does not assign IP addresses using DHCP, set the IP address manually.
• Make sure your computer and product are both using the same wireless network.
• If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place your product closer to your router or access point. Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. See your router documentation for instructions.

• Make sure your printer is selected as the default printer.
• Check if the selected printer port is correct.

• Check to see if your wireless router or access point has an enabled Privacy Separator function that is preventing printing from a device over the network. See your router or access point documentation for instructions on disabling the Privacy Separator function.

• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product's LCD screen is not lit, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.

• Check your wired LAN router or access point to see if the LED for the port to which your product is connected is on or flashing. If the link LED is off, try the following:
  • Make sure the Ethernet cable is securely connected to your product and to your router, access point, switch, or hub.
  • Try connecting your product to a different port or a different router, access point, switch, or hub.
  • Try connecting with a different Ethernet cable.
  • Try printing to your product from another computer on the network.

  **Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. See your router documentation for instructions.

• If you are connecting the product via EpsonNet Setup and the Wi-Fi icon does not appear lit on the LCD screen, make sure your product software was installed correctly. If necessary, reinstall your software.

**Parent topic:** Solving Network Problems

**Related tasks**

Printing a Network Status Sheet

---

**Solving Printing Problems**

Check these sections if you have problems printing with your product.

**Nothing Prints**

**Print Head Moves But Nothing Prints**

**Parent topic:** Solving Problems
Nothing Prints

If you have sent a print job and nothing prints, try these solutions:

• Make sure your printer is turned on.
• Make sure there are no errors on the screen.
• If you have \textit{Print Preview} enabled in your printer driver, the preview appears after you click Print but before printing starts. Disable this setting if you want printing to start immediately.
• Make sure any interface cables are connected securely at both ends. If you have a spare cable, try connecting with the spare cable.
• Check the model and specifications of the interface cable to see if the cable is appropriate for your computer and printer.
• If you connected your printer to a USB hub, make sure it is a first-tier hub. If it still does not print, connect your printer directly to your computer instead of the hub.
• Make sure the USB hub is recognized correctly on the computer. Disconnect all USB hubs from the computer and connect the printer directly to the computer's USB port.
• Make sure the USB cable length does not exceed 10 feet (3 m).

\textbf{Parent topic:} Solving Printing Problems

\textbf{Related references}

\textit{Interface Specifications}

Print Head Moves But Nothing Prints

If the print head is moving and nothing prints, try these solutions:

• Print a nozzle check pattern. If the pattern does not print correctly, clean the print head again. (If the printer has not been used for a long time the nozzles may be clogged.)
• If you see the message \textbf{Motor Self Adjustment} on the product's LCD screen, the printer is adjusting its internal motor. Wait a few moments for the message to disappear and do not turn off the printer.

\textbf{Parent topic:} Solving Printing Problems

\textbf{Related concepts}

\textit{Print Head Nozzle Check}
\textit{Print Head Cleaning}
Solving Paper Problems

Check these sections if you have problems using paper with your product.

Paper Feeding Problems
Printout Quality Problems
Roll Paper Jam Problems
Cut Sheet Paper Jam Problems

Parent topic: Solving Problems

Paper Feeding Problems

If you have problems feeding paper, try these solutions:

• Make sure paper is loaded in the correct orientation. Load cut sheets vertically (short edge first).
• For best results, follow these guidelines:
  • Use new, smooth, high-quality paper that is not damp, curled, creased, old, too thin, or too thick.
  • Follow any special loading instructions that came with the paper.
• If roll paper does not feed, cut the end straight across and uncurl it by rolling it backward, if necessary. Then reload the paper.
• Make sure there are no gaps between the roll paper and the paper stops on the spindle.
• If wrinkles appear on roll paper, adjust the Back Tension setting.
• If you cannot insert paper easily into the paper feed slot, make sure the paper is perfectly flat and not curled.
• Do not load more than one piece of cut sheet paper.
• Make sure your paper meets the specifications for your product.
• Make sure you selected the Media Type setting in the printer driver that matches the paper you loaded in the product.
• Make sure that paper is not jammed inside the product.
• Make sure you are using the product in the proper room temperature.

Parent topic: Solving Paper Problems
Related references
Paper Setting Menu
Paper Specifications
Printout Quality Problems

If your printout does not cut cleanly or does not eject into the paper basket*, try these solutions:

• Replace the cutter.
• Manually cut the paper after the image is printed. Make sure the **Auto Cut** setting is turned off.
• Use your hands to lightly press the paper into the paper basket as it is ejected from the printer.
• If the paper creases as it ejects into the paper basket, close the paper basket and support the printout with your hands before it touches the floor.

*The paper basket and stand are optional for the SureColor T3170.

Parent topic: Solving Paper Problems

Related tasks
- Cutting Roll Paper Manually
- Replacing the Cutter

Roll Paper Jam Problems

If roll paper has jammed in the printer, follow the steps here to clear the jam.

1. Open the cut sheet cover.

*The paper basket and stand are optional for the SureColor T3170.*
2. Release the central lock and open the roll paper cover.

3. Cut the paper above the paper feed slot.

4. Close the roll paper cover and the cut sheet cover.
5. Remove the jammed paper from the front of the product.
6. Open the front cover and remove any other jammed paper as necessary.

![Image of removing jammed paper]

**Note:** Do not touch the print head.

7. Close the front cover.
8. Turn the printer off and on.
9. Cut the edge of the roll paper straight horizontally, and reload the roll paper.

**Note:** Make sure to cut off any jagged or folded sections of paper.

**Parent topic:** Solving Paper Problems

**Related tasks**
- Loading Roll Paper
- Cutting Roll Paper Manually

### Cut Sheet Paper Jam Problems

If cut sheet paper has jammed in the product, follow the steps here to clear the jam.

1. Remove any jammed paper from the front of the product.

![Image of removing jammed paper]
2. Open the front cover.

3. Remove any other jammed paper as necessary.

   Note: Do not touch the print head.

4. Close the front cover.
5. Turn the printer off and on.
6. Reload a cut sheet.

Parent topic: Solving Paper Problems

Related tasks
Loading Single Cut Sheets
Loading Paper in the Auto Sheet Feeder

Solving Print Quality Problems

Check these sections if you have problems with print quality.

Overall Print Quality is Poor
Lines Are Misaligned
Prints are Scuffed or Smeared
Prints are Not Positioned Properly
Overall Print Quality is Poor

If you notice that your print quality is uneven, too light, too dark, or there are lines in the print (banding), try these solutions:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary. If nozzles are still clogged after cleaning three times, perform a Powerful Cleaning.

• Perform a print quality adjustment.

• Make sure your paper meets the specifications for your product.

• Make sure the paper is not wrinkled, folded, or bent.

• Make sure your ink cartridges have not expired. For best results, use ink cartridges before the expiration date printed on the package (within six months of installation in the printer). Replace expired cartridges with new ones.

• Shake the cartridges before installing them in the printer.

• Make sure you selected the correct Media Type setting in the printer driver that matches the paper loaded in the printer.

• Compare the print result with the image on your computer screen. Since monitors and printers produce colors differently, printed colors and screen colors do not always look the same.

• Make sure that all printer covers are closed during printing.

• Keep all printer covers closed unless you are loading or unloading media to prevent dust from accumulating inside the printer.

• Check the ink levels on the LCD screen. Replace any cartridges that are low on ink.

• Enable color management in the software application or in the printer driver.

• If you are using non-Epson media, make sure you create a custom paper configuration for the media.

• Check the quality setting that you selected in the printer driver. Using a faster printing method may decrease the overall print quality.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Lines Are Misaligned

You may see vertical lines in the (bi-directional) print output. If this occurs, try these solutions:

- Perform a print quality adjustment.
- Make sure you selected the correct Media Type setting in the printer driver that matches the paper loaded in the printer.

Prints are Scuffed or Smeared

If your prints are scuffed or smeared, try these solutions:

- Make sure your paper meets the specifications for your product.
- Make sure you selected the correct Media Type setting in the printer driver that matches the paper loaded in the printer.
- Do not use paper with folds or creases and always use new media.
- If you are using cut sheet paper, check that changes in humidity and temperature have not made the paper wavy or curled up on the edges. Flatten the paper before loading it or use new paper.
- If the surface of the paper is scuffed, select a wider Platen Gap setting.
- If you are printing on thick paper, make sure the Thick Paper setting is enabled in the Printer Settings menu.
• If the bottom edge is scuffed, try widening the bottom margin.
• If ink is smeared on your prints, clean the rollers. Load blank paper and perform a paper guide cleaning.
• If you are using non-Epson media, make sure you create a custom paper configuration for the media. 
• Depending on the print density and type of paper you are using, the ink may take a while to dry. Do not stack the prints until the ink is completely dry. You can adjust the drying time in the Printer Settings menu.
• Adjust the ink density in the printer driver settings and on the control panel for custom paper configuration settings.

Parent topic: Solving Print Quality Problems

Related references
Paper Specifications
Paper Setting Menu
Printer Settings Menu

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Creating Custom Paper Configurations
Cleaning the Auto Sheet Feeder
Cleaning the Roll Paper Feeder

Prints are Not Positioned Properly

If your prints are not positioned properly on the media, try these solutions:
• Make sure your print settings in the control panel and the printer driver match.
• Make sure the Document Size or Paper Size setting in the printer driver matches the paper loaded in the product.
• Check for paper skew errors on the LCD screen. Make sure the Detect Paper Meandering setting in Printer Settings is set to On.
• Margin settings made in the printer driver have priority over margin settings made in the control panel.

Parent topic: Solving Print Quality Problems

Related references
Printer Settings Menu
Too Much Ink is Consumed

If your printer is consuming too much ink during printing, try these solutions:

- Make sure you selected the **Media Type** setting in the printer driver that matches the paper you loaded in the printer. The amount of ink used during printing is controlled by the **Media Type** setting.
- Lower the density of ink in the paper or media options in the printer driver and on the control panel for custom paper configuration settings.

**Parent topic:** Solving Print Quality Problems

**Related tasks**
- Selecting Basic Print Settings - Windows
- Selecting Basic Print Settings - Mac

Cannot Make Enlarged Copies from Scanner

If you cannot make enlarged copies from a scanner connected to your printer, try these solutions:

- Make sure all cables are securely connected and the scanner is turned on.
- Make sure the scanner connected to the printer is compatible. Visit the Epson website for the most updated list of supported scanners.

**Parent topic:** Solving Problems

**Related tasks**
- Connecting a Scanner to Your Printer

Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for your operating system.

**Parent topic:** Solving Problems

**Related tasks**
- Uninstalling Product Software - Windows
- Uninstalling Product Software - Mac
Uninstalling Product Software - Windows

You can uninstall and then re-install your printer software to solve certain problems.

1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:
   - **Windows 10**: Right-click and select Control Panel > Programs > Programs and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.
     
     **Note**: If you see a User Account Control window, click Yes or Continue.

     Select your product again, if necessary, then select OK, and click Yes to confirm the uninstallation.

   - **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Programs > Programs and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

     **Note**: If you see a User Account Control window, click Yes or Continue.

     Select your product again, if necessary, then select OK, and click Yes to confirm the uninstallation.

   - **Windows (other versions)**: Click or Start, and select All Programs or Programs. Select Epson, select your product, then click EPSON Printer Software Uninstall.

     **Note**: If you see a User Account Control window, click Yes or Continue.

     In the next window, select your product and click OK. Then follow any on-screen instructions.

4. Restart your computer, then re-install your software.

**Note**: If re-installing your product software does not solve a problem, contact Epson support.

**Parent topic**: Uninstall Your Product Software

**Related references**

Where to Get Help
Uninstalling Product Software - Mac

In most cases, you do not need to uninstall your product software before re-installing it. However, you can download the Uninstaller utility from the Epson support website to uninstall your product software as described here.

**Note:** If re-installing your product software does not solve a problem, contact Epson support.

1. To download the Uninstaller utility, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.
2. Click **Downloads**.
3. Select your operating system, click **Utilities**, locate the Uninstaller utility, and click **Download**.
4. Run the file you downloaded.
5. Double-click the **Uninstaller** icon.
6. In the Epson Uninstaller screen, select the checkbox for each software program you want to uninstall.
7. Click **Uninstall**.
8. Follow the on-screen instructions to uninstall the software.
9. Reinstall your product software.

**Note:** If you uninstall the printer driver and your product name remains in the **Print & Fax**, **Print & Scan**, or **Printers & Scanners** window, select your product name and click the – (remove) icon to remove it.

---

**Parent topic:** Uninstall Your Product Software

**Related references**

Where to Get Help

---

**Where to Get Help**

Epson provides technical support and information on the installation, configuration, and operation of professional printing products through the Epson Preferred Limited Warranty Plan. Dial (888) 377-6611, 6 AM to 6 PM, Pacific Time, Monday through Friday. Days and hours of support are subject to change without notice.

**Note:** If you experience difficulty with the toll-free number, call (562) 276-1305 (U.S.).
Before you call, make sure you have your printer serial number and proof of purchase. Visit epson.com/support (U.S.) or epson.ca/support (Canada) and select your product for solutions to common problems. You can download drivers, firmware, and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

**Note:** For help using any other software on your system, see the documentation for that software for technical support information.

**Purchase Supplies and Accessories**

You can purchase genuine Epson ink, paper, and accessories from an Epson authorized reseller. To find the nearest reseller, visit proimaging.epson.com (U.S.) or proimaging.epson.ca (Canada), select your product series and product, and click the **Where to Buy** button. Or call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

**Parent topic:** Solving Problems
Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this site (Canada) for information on how to return your Epson products for proper disposal.

Windows System Requirements
Mac System Requirements
Paper Specifications
Printable Area Specifications
Ink Cartridge Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements

To use your product and its software, your computer should meet these requirements.

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Core 2 Duo 3.05 GHz or better</td>
</tr>
<tr>
<td>Memory</td>
<td>1GB or more</td>
</tr>
<tr>
<td>Hard disk space available</td>
<td>32GB or more</td>
</tr>
<tr>
<td>Display resolution</td>
<td>WXGA (1280 × 800) or higher</td>
</tr>
</tbody>
</table>
**Note:** For the latest product software available for your operating system, visit the Epson support site at.epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean), select your product, and select **Downloads**.

**Parent topic:** Technical Specifications

## Mac System Requirements

To use your product and its software, your Mac should meet these requirements.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS X version</td>
<td>Mac OS X 10.7 through macOS 10.13.x</td>
</tr>
<tr>
<td>CPU</td>
<td>Core 2 Duo 3.05 GHz or better</td>
</tr>
<tr>
<td>Memory</td>
<td>4GB or more</td>
</tr>
<tr>
<td>Hard disk space</td>
<td>32GB or more</td>
</tr>
<tr>
<td>available</td>
<td></td>
</tr>
<tr>
<td>Display resolution</td>
<td>WXGA+ (1440 × 900) or higher</td>
</tr>
</tbody>
</table>

**Note:** For the latest product software available for your operating system, visit the Epson support site at.epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean), select your product, and select **Downloads**.

**Parent topic:** Technical Specifications

## Paper Specifications

**Note:** Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a sample of paper stock before purchasing large quantities or printing large jobs.

### Roll paper

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core size</td>
<td>2 inches (51 mm)</td>
</tr>
<tr>
<td>Outer diameter</td>
<td>Up to 4.33 inches (110 mm)</td>
</tr>
</tbody>
</table>
| Width           | **SureColor T3170**: 13 to 24 inches (329 to 610 mm)  
**SureColor T5170**: 13 to 36 inches (329 to 914 mm) |
<table>
<thead>
<tr>
<th>Thickness</th>
<th>0.002 to 0.008 inch (0.05 to 0.21 mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>Up to 6.61 lbs (3 kg)</td>
</tr>
</tbody>
</table>

**Cut sheet paper (auto sheet feeder)**

<table>
<thead>
<tr>
<th>Size</th>
<th>Size details</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A4 (8.3 × 11.7 inches [210 × 297 mm])</td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm])</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 × 14 inches [216 × 356 mm])</td>
</tr>
<tr>
<td>Thickness</td>
<td>0.005 to 0.01 inch (0.12 to 0.27 mm)</td>
</tr>
<tr>
<td>Loading capacity</td>
<td>Plain paper: 50 sheets</td>
</tr>
<tr>
<td></td>
<td>Other paper types: 5 sheets</td>
</tr>
</tbody>
</table>

**Cut sheet paper (1 sheet)**

<table>
<thead>
<tr>
<th>Width</th>
<th>SureColor T3170: 8.23 to 24 inches (210 to 610 mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>SureColor T5170: 8.23 to 36 inches (210 to 914 mm)</td>
</tr>
<tr>
<td>Length</td>
<td>11 to 46.8 inches (279.4 to 1189 mm)</td>
</tr>
<tr>
<td>Thickness</td>
<td>0.005 to 0.01 inch (0.12 to 0.27 mm)</td>
</tr>
</tbody>
</table>

Parent topic: Technical Specifications
Printable Area Specifications

Roll paper

Note: Margins may change depending on the Top/Bottom Margins setting that you select. The numbers below are the standard settings.

1  Printable width:
   SureColor T3170: 12.95 to 24 inches (329 to 610 mm)
   SureColor T5170: 12.95 to 36 inches (329 to 914 mm)
2  Printable length: 11 to 708.67 inches (279.4 to 18000 mm)
3  Left/right margin: 0.12 inch (3 mm) minimum
4  Bottom margin: 0.12 to 1.77 inches (3 to 45 mm)
5  Top margin: 0.12 to 1.18 inches (3 to 30 mm)
Cut sheet (auto sheet feeder)

1. Printable width: 8.27 to 11.69 inches (210 to 297 mm)
2. Left/right/top/bottom margin: 0.12 inch (3 mm)
3. Printable length: 10.98 to 16.54 inches (279 to 420 mm)

Cut sheet (1 sheet)
Ink Cartridge Specifications

**Note:** We recommend that you use genuine Epson cartridges and do not refill them. The use of other products may affect your print quality and could result in printer damage.

The cartridges included with the printer are designed for printer setup and not for resale. After some ink is used for charging, the rest is available for printing. Yields vary considerably based on images printed, print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink remains in the cartridge after the "replace cartridge" indicator comes on.

<table>
<thead>
<tr>
<th>Type</th>
<th>Epson ink cartridges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pigment ink</td>
<td>Cyan, Magenta, Yellow, Black</td>
</tr>
<tr>
<td>Cartridge life</td>
<td>See the expiration date on the package or cartridge</td>
</tr>
<tr>
<td>Print quality guarantee</td>
<td>6 months after unpacking</td>
</tr>
<tr>
<td>Temperature</td>
<td>Transportation (in package): –4 to 140 °F (–20 to 60°C)</td>
</tr>
<tr>
<td></td>
<td>Storage (in package and after installation): –4 to 104 °F (–20 to 40°C)</td>
</tr>
<tr>
<td></td>
<td>1 month at 104°F (40°C)</td>
</tr>
<tr>
<td></td>
<td>Ink freezes at 9°F (–13°C)</td>
</tr>
<tr>
<td></td>
<td>Ink thaws and is usable after 3 hours at 77°F (25°C)</td>
</tr>
</tbody>
</table>
Cartridge dimensions
80 ml:
Width: 1.61 inches (41 mm)
Depth: 3.82 inches (97 mm)
Height: 1.95 inches (49.5 mm)
50 ml/26 ml:
Width: 1.06 inches (27 mm)
Depth: 3.82 inches (97 mm)
Height: 1.95 inches (49.5 mm)

Parent topic: Technical Specifications
Related references
Ink Cartridge and Maintenance Box Part Numbers

Dimension Specifications

SureColor T3170
Dimensions include the attached output tray.

Height 35.94 inches (913 mm)
Width 38.19 inches (970 mm)
Depth 38.67 inches (982 mm)
Weight 83.78 lb (38 kg)
(without ink cartridges or output tray)

SureColor T5170
Dimensions include the opened paper basket and the attached output tray.

Height 35.94 inches (913 mm)
Width 49.92 inches (1268 mm)
Depth 38.67 inches (982 mm)
Weight
101.41 lb (46 kg)
(without ink cartridges or output tray)

Parent topic: Technical Specifications

Electrical Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply rating</td>
<td>100 to 240 V</td>
</tr>
<tr>
<td>Rated frequency range</td>
<td>50/60 Hz</td>
</tr>
<tr>
<td>Rated current</td>
<td>1.4 A</td>
</tr>
<tr>
<td>Power consumption</td>
<td>Printing: approximately 28 W</td>
</tr>
<tr>
<td></td>
<td>Ready mode: approximately 8.0 W</td>
</tr>
<tr>
<td></td>
<td>Sleep mode: approximately 1.6 W</td>
</tr>
<tr>
<td></td>
<td>Power off mode: approximately 0.2 W</td>
</tr>
</tbody>
</table>

Parent topic: Technical Specifications

Environmental Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>Operating: 50 to 95 °F (10 to 35 °C)</td>
</tr>
<tr>
<td></td>
<td>Operating (recommended): 59 to 77 °F (15 to 25 °C)</td>
</tr>
<tr>
<td></td>
<td>Storage (before unpacking): –4 to 140 °F (–20 to 60 °C)</td>
</tr>
<tr>
<td></td>
<td>1 month at 104 °F (40 °C)</td>
</tr>
<tr>
<td></td>
<td>Storage (after unpacking): 14 to 104 °F (–10 to 40 °C)</td>
</tr>
<tr>
<td></td>
<td>1 month at 104 °F (40 °C)</td>
</tr>
<tr>
<td>Humidity</td>
<td>Operating: 20 to 80% RH</td>
</tr>
<tr>
<td></td>
<td>Operating (recommended): 40 to 60% RH</td>
</tr>
<tr>
<td></td>
<td>Storage: 5 to 85% RH</td>
</tr>
</tbody>
</table>

Parent topic: Technical Specifications
Interface Specifications

| Interface type | High-Speed USB port compatible with USB 2.0 specification (OPTION port)
|                | SuperSpeed USB port compatible with USB 3.0 specification (USB port)

Parent topic: Technical Specifications

Network Interface Specifications

Wi-Fi

<table>
<thead>
<tr>
<th>Standards</th>
<th>IEEE802.11b/g/n</th>
</tr>
</thead>
<tbody>
<tr>
<td>Securities</td>
<td>WEP (64/128bit)</td>
</tr>
<tr>
<td></td>
<td>WPA-PSK (TKIP)</td>
</tr>
<tr>
<td></td>
<td>WPA2-PSK (AES) (complies with WPA2 standards with support for WPA/WPA2 Personal)</td>
</tr>
<tr>
<td>Frequency range</td>
<td>2.4 GHz</td>
</tr>
<tr>
<td>Communication mode</td>
<td>Infrastructure</td>
</tr>
<tr>
<td></td>
<td>Wi-Fi Direct (Simple AP) (not supported for IEEE802.11b)</td>
</tr>
</tbody>
</table>

Security Protocols

- SSL/TLS (HTTPS Server/Client, IPPS)
- IEEE802.1X
- IPsec/IP Filtering
- SMTPS (STARTTLS, SSL/TLS
- SNMPv3
Ethernet Standards

IEEE802.3i (10BASE-T)
IEEE802.3u (100BASE-TX)
IEEE802.3ab (1000BASE-T)
IEEE802.3az (Energy Efficient Ethernet); connected device should comply with IEEE802.3az standards

Note: Use a category 5 or higher shielded twisted pair cable for all interfaces.

Parent topic: Technical Specifications

Safety and Approvals Specifications

United States
Safety: UL60950-1
EMC: FCC part 15 Subpart B class B

Canada
Safety: CAN/CSA C22.2 No. 60950-1
EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module:
- Manufacturer: Epson
- Type: WLU6320-D69 (RoHS)

This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-recommended modification of the product. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102 of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities: hands, wrists, feet and ankles).

Parent topic: Technical Specifications
Important Safety Instructions

Before using your Epson product, read and follow these safety instructions.

- Be sure to follow all warnings and instructions marked on the product.
- Use only the type of power source indicated on the product's label.
- Use only the power cord that comes with the product. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
- Place the product near a wall outlet where the plug can be easily unplugged.
- Connect your product to a properly grounded power outlet. Avoid plugging the product into an outlet on the same circuit as a photo copier or air control system that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
- Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or run over. Be careful to keep the cord straight at each end.
• If you use an extension cord with the product, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

• If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are fuses in the plug, make sure you replace them with fuses of the correct size and rating.

• Always turn off the product using the power button, and wait until the power light stops flashing before unplugging the product or cutting off power to the electrical outlet.

• If you will not be using the product for a long period, unplug the power cord from the electrical outlet.

• Place the product on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.

• Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

• Do not place or store the product outdoors.

• Do not place the product near excessive heat sources or in direct sunlight.

• Leave enough room around the product for sufficient ventilation. Do not block or cover openings in the cabinet or insert objects through the slots.

• Keep the product away from potential sources of electromagnetic interference, such as loudspeakers or the base units of cordless telephones.

• When connecting the product to a computer or other device with a cable, ensure the correct orientation of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may damage both devices connected by the cable.

• Do not put your hands inside the product or touch the ink cartridges while printing.

• Do not move the print head by hand; this may damage the product.

• Do not spill liquid on the product or use the product with wet hands.

• Do not use aerosol products that contain flammable gases inside or around the product. Doing so may cause fire.

• Except as specifically explained in your documentation, do not attempt to service the product yourself.

• Unplug the product and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the cabinet damaged; if the product does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.

• Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may prevent the product from printing.
• Before storing the product, make sure the print head is positioned at the far right.
• When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down; otherwise ink may leak.

Note: The lithium batteries in this product contain Perchlorate Material - special handling may apply. Click here for details.

Parent topic: Important Safety Instructions

Ink Cartridge Safety Instructions

• Keep ink cartridges out of the reach of children and do not drink the ink.
• Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.
• Do not put your hand inside the product or touch any cartridges during printing.
• Install a new ink cartridge immediately after removing an expended one. Leaving cartridges uninstalled can dry out the print head and may prevent the product from printing.
• Install ink cartridges in all the ink cartridge slots. You cannot print if any of the slots are empty.
• Dried ink on the supply port may cause ink leaks when the cartridge is reinserted and used. Wipe off any excess ink before reinserting.
• Do not insert or remove replacement cartridges during printing.
• Do not remove the transparent seal from the ink supply port. This may cause the cartridge to become unusable.
• The green IC chip on this ink cartridge retains a variety of cartridge-related information, such as the ink cartridge status, so that the cartridge may be removed and reinserted freely. Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation and printing.
• If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the product. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.
• To ensure print quality, use an ink cartridge before the date printed on its package.
• Do not dismantle or alter an ink cartridge. This could damage the print head and may prevent the product from printing.
• Do not drop cartridges or bump them against hard objects; otherwise, the ink may leak.
• Store ink cartridges at room temperature in a location that is not exposed to direct sunlight.
• After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.

Parent topic: Important Safety Instructions

LCD Screen Safety Instructions

• Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
• If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.
• Do not press too hard on the LCD screen or subject it to heavy impacts.
• Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
• If the LCD screen chips or cracks, do not touch or attempt to remove the broken pieces; contact Epson for support.
• Do not subject your product to sudden changes in temperature or humidity; this may cause condensation to develop inside the LCD screen and degrade its performance.

Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions

Radio waves from this product may adversely affect the operation of medical equipment or automatically controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near such devices or inside a medical facility, follow the directions from authorized staff members at the facility, and follow all posted warnings and directions on the device to avoid causing an accident.

Parent topic: Important Safety Instructions

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult an authorized dealer or service representative for help.
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification or Declaration of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
CAN ICES-3(B)/NMB-3(B)

Parent topic: Notices

Binding Arbitration and Class Waiver

1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS

1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term "Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim, controversy or action between you and Epson arising out of or relating to this Agreement, Epson branded products (hardware and including any related software), or other transaction involving you and Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation, ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement, (c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson also agree, notwithstanding Section 1.6,that a court, not an arbitrator, may decide if a claim or cause of action is for an IP Claim.

1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED. Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized
arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C. §1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this Agreement.

1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to resolve the Dispute within the sixty (60) days, you or Epson may commence an arbitration. Notice to Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3840 Kilroy Airport Way, Long Beach, CA 90806 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent address Epson has in its records for you. For this reason, it is important to notify us if your address changes by emailing us at EAILegal@ea.epson.com or writing us at the Epson Address above. Notice of the Dispute shall include the sender's name, address and contact information, the facts giving rise to the Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson and you agree to act in good faith to resolve the Dispute before commencing arbitration.

1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small claims court of your state or municipality if the action is within that court's jurisdiction and is pending only in that court.

1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED. ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION PROCEEDING.

1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration on a class or representative basis (the "JAMS Rules"), available at http://www.jamsadr.com or by calling 1-800-352-5267, and under the rules set forth in this Agreement. All Disputes shall be resolved by a single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising out of or relating to the interpretation, applicability, enforceability or formation of this Agreement, including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad
delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1 above. The arbitrator shall be empowered to grant whatever relief would be available in a court under law or in equity. The arbitrator may award you the same damages as a court could, and may award declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent necessary to provide relief warranted by that party's individual claim. In some instances, the costs of arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration than in court. The arbitrator's award is binding and may be entered as a judgment in any court of competent jurisdiction.

You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by telephone shall take place in a location reasonably accessible from your primary residence, or in Orange County, California, at your option.

a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties agree to the following procedure:

(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount of damages sought to be recovered. You can find a copy of a Demand for Arbitration at http://www.jamsadr.com ("Demand for Arbitration").

(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North State College Blvd., Suite 600 Orange, CA 92868, U.S.A.

(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute Notice), or as otherwise agreed by the parties.

b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled. The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during the arbitration.

c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.

d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and expenses to be paid by Epson pursuant to this Section 1.6d).

e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section
1.6d) above does not limit your rights to attorney’s fees and expenses under applicable law; notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney’s fees and expenses.

1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual arbitration procedure and waiver of class and representative proceedings specified in this Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent to this Agreement (including without limitation the purchase, download, installation of the Software or other applicable use of Epson Hardware, products and services) that specifies (i) your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding individual arbitration procedure and waiver of class and representative proceedings specified in this Section 1. In the event that you opt-out consistent with the procedure set forth above, all other terms shall continue to apply, including the requirement to provide notice prior to litigation.

1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and class action waiver provisions (other than a change to Epson’s address) in this Agreement, Epson will obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you timely elected to opt-out when you first assented to this Agreement).

1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not apply to the prohibition against class or representative actions as provided in Section 1.5. This means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1) shall be null and void.

Parent topic: Notices

**Trademarks**

EPSON®, SureColor®, and PrecisionCore® are registered trademarks and EPSON Exceed Your Vision is a registered logomark of Seiko Epson Corporation.

Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.

Apple, App Store, AirPrint, AirPrint logo, iPad, iPhone, iPod touch, Mac, and OS X are trademarks of Apple Inc., registered in the U.S. and other countries.

Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.
General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables other than those designated as Epson approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to sleep to a shorter interval.

Parent topic: Copyright Notice

Copyright Attribution

© 2018 Epson America, Inc.
8/18
CPD-56163

Parent topic: Copyright Notice